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[bookmark: _Toc57986845]INTRODUCTION 
Pearson is committed to accessibility and is taking all possible measures to make the online learning experience accessible for all learners. The PDF Accessibility Playbook was put together to provide content producers with the guidance required for creating accessible PDF documents and offer buyers courses that not only have web content that is accessible but also accessible PDF documents.
The playbook includes techniques for implementing accessibility across different PDF elements, such as headings, lists, images, tables, forms, etc. It identifies both techniques that must be adopted, and techniques that should be avoided, from an accessibility perspective. Along with the techniques, the playbook lists tips, and tricks for enhancing accessibility. 
The playbook comprises of examples of different Pearson PDF documents and lists possible solutions to help the team implement accessibility. Not only will the playbook serve as a valuable reference, it can also equip the team to implement accessibility while designing and authoring all future Pearson PDF documents. 
[bookmark: _Toc52289363][bookmark: _Toc52291019][bookmark: _Toc57986846]Intended Audience 
The PDF Accessibility Playbook is intended for the entire technical team that works to author, as well as maintain, Pearson’s PDF documents. Team members include: 
· UI designers
· UX professionals
· Content Digitizer
· Content writers
· Courseware Quality Assurance (QA) teams
[bookmark: _Toc52289364][bookmark: _Toc52291020][bookmark: _Toc57986847]INTRODUCTION TO ACCESSIBILITY
Accessibility refers to making a product or service usable for as many people as possible. In the digital space, accessibility ensures that websites, applications, documents, online learning solutions etc. are usable for all users including those with disabilities. Often accessibility is viewed at something that is meant for people with disabilities. However, accessibility benefits each one of us in different situations.
Today digital accessibility has been adopted in most countries across the globe. To make accessibility happen, there are standards, guidelines and specifications that outline ways to make it a reality. Technologies include support for developing accessible solutions and the demand for accessible products is increasing by the day. 
In simple terms, accessibility is ensuring that everyone can use a product or service irrespective of their abilities or situation of use. In physical space, we may refer to accessibility as providing ramps to allow people on a wheelchair to come in easily similarly in the case of digital accessibility it refers to making the online solutions available for all users including those using assistive technologies. 
[bookmark: _Toc49798640][bookmark: _Toc52289365][bookmark: _Toc52291021][bookmark: _Toc57986848]What is PDF Accessibility? 
PDF accessibility is a practice where documents and forms are designed, authored, and maintained in a manner that people with disabilities can use them with accessibility features turned on as well as with assistive technologies. PDF accessibility makes it possible for people with disabilities to access the content, interact with the functionality, understand the content, and use the content with their assistive technology.
Accessible PDF documents ensure that learners with mobility disabilities can fill out PDF forms without having to go through the hassle of waiting in long queues for submitting their assignments. Accessible PDF documents makes it possible for learners with hearing disabilities to listen to recorded lectures by following synchronized captions. Similarly, learners with visual impairments can perceive complex images by reading the alternate descriptions with their assistive technologies and those with learning disabilities can access the content with assistive technologies such as Text to Speech reading tools. 

[bookmark: _Toc49798641][bookmark: _Toc52289366][bookmark: _Toc52291022][bookmark: _Toc57986849]Need for Accessibility
PDF documents are present online on almost every portal and this is no different when it comes to online learning.  Most of our daily digital activities from learning, banking, employment, healthcare, and government procedures involve access to PDF documents. Access to PDF content is therefore essential for all users including for those with disabilities. 
Some of the key benefits of digital accessibility that is applicable for PDF documents as well include:
· Ensures access to essential online activities for all users
· Increase in customer base 
· Helps to conform with accessibility standards and guidelines.
· Builds brand loyalty
· Drives innovation by making solutions that are accessible for wide range of users
· Adhere to legal requirements 
· Contribute towards building an inclusive society.

[bookmark: _Toc49798642][bookmark: _Toc52289367][bookmark: _Toc52291023][bookmark: _Toc57986850]How people with disabilities use PDF documents?
Ever thought how someone who cannot see will access diagrams explaining functions of different body parts? Or how someone who cannot listen will access a recorded video lecture explaining the solar system embedded in a PDF document? How someone with upper limb difficulties will complete their interactive assignments?  Technology acts as an enabler for people with disabilities and they can read text books, submit their assignments, fill up their tax applications, read their utility bills and many more day to day activities available in PDF format. 
Digital evolution has made life very easy for all of us and more so for people with disabilities as they can accomplish their tasks independently. People with disabilities use different assistive technologies to access the PDF documents either using a computer, tablet, or mobile device. 
Let us learn about few of the assistive technologies used by people with disabilities to access PDF documents:
Visual Disabilities
· Screen readers: reads out the information displayed in a PDF document for their users. Users can access the information by listening to the screen reader and using a keyboard to input the data or give commands. Screen readers rely on PDF tags to identify the information for their users. Screen readers also provide their users with option to access different PDF elements using different keystrokes. 
· Screen magnifiers: enlarges the information displayed in a PDF document for their users. Users can access the information by either using a mouse or a keyboard. Since users access the information in an enlarged form, not all the information is visible on the screen. This requires users to scroll a lot to access the information.  
· Refreshable Braille Displayers: is a piece of hardware which can be attached to a computer, tablet, or mobile phone. It works in combination with a screen reader. The information read out by a screen reader is refreshed on the braille displayer and users can touch the braille pins and read the information. Users can read the information using the braille displayer whereas they can input the data using a keyboard. Refreshable braille displayers are used by blind and deaf-blind users.
Hearing Disabilities:
· Synchronized captions help people with hearing disabilities access videos and text transcripts help them to access audio-only content with ease. They do not require any assistive technology as such to access the PDF content. 
Learning Disabilities:
· Text to speech synthesizers (TTS): reads out the text displayed on the screen as well as highlights the text. This helps users in understanding the information when it is read out to them. TTS software also provide users with options to view the information using different contrast themes. 
· Word prediction tools: predicts words while users are typing data. These tools are found very helpful by users with learning disabilities especially while filling up forms as they do not have to memorize spellings. 
Mobility Disabilities:
· Adaptive keyboards: come in different shapes and sizes to meet user’s needs. Split keyboards (where the standard keyboard is split in two parts), one handed keyboard (which are adapted for users who do not have one hand), keyboards used in the bank that have multiple keys with combination of the digit 0 etc. are some of the examples of adaptive keyboards. These keyboards are used by people with mobility disabilities to meet their needs. 
· Sip-n-puff devices: are used by people with severe mobility disabilities, such as those who have issues with upper and lower limbs. With sip-n-puff devices, people can use their breath to click on a button or a link. While typing, people using sip-n-puff devices use the onscreen keyboards (readily available in different operating systems) with their device to fill up the details. 
· Onscreen keyboards: are virtual keyboards that are used by people who find it difficult to press the keys on a hardware keyboard. Onscreen keyboards are often used in combination with other hardware devices, such as eye tracking tools, head mouse etc. 
· Voice recognition systems: is a software using which people can control their computer by giving voice commands. Users can click on links or buttons, dictate their details while filling up forms etc. Adding descriptive label for links and buttons allow users to give accurate voice commands while accessing information of a PDF document. 

Some of the assistive technologies are today available with different operating systems, such as Windows, Mac OS, iOS, Android, Linux, Chrome OS etc. All in all, people with disabilities have many choices when it comes to assistive technologies and access their digital documents.  
Acrobat Reader is the most widely used PDF reader available for different operating systems. Acrobat Reader provides a range of accessibility features for the benefit of users with disabilities. Acrobat Reader not only includes a range of accessibility features, but also follows user’s system settings and is compatible with third party assistive technologies, such as screen readers and screen magnifiers. 
Acrobat Reader includes a range of accessibility features for users with different types of disabilities. These features can mainly be accessed via the “Accessibility” and “Reading” options available in the Preferences (Edit>Preferences) dialog. For the benefit of mobility impaired users, it provides a list of keyboard shortcuts that help users carry out different tasks. Additionally, auto-complete option allows users to fill up forms with fewer keystrokes. It provides multimedia accessibility features, such as ability to turn on subtitles, captions, and audio description, when available. 
Acrobat Reader provides options to adjust the contrast themes, text-to-speech (Read Out Loud), replace document colors, etc. to help users with learning impairments access the documents with ease. The Zoom and Reflow options help users with low vision access the document content easily. It is compatible with leading screen readers (both free as well as commercial), thereby allowing users with visual impairments to access the document content. 
[image: ]

Across the globe there are several accessibility standards and guidelines that have been laid out for making PDF documents accessible. However, accessibility standards and guidelines that are widely used for making accessible PDF documents include Web Content Accessibility Guidelines (WCAG) 2.1 and PDF Universal Accessibility (PDF/UA) standards. WCAG 2.1 offers several techniques for making PDF documents accessible and we will be referring to different success criteria’s that are applicable to PDF documents in this playbook. Pearson has their own accessibility standpoint when it comes to accessibility guidelines and standards for different technologies so let us discuss that now.

[bookmark: _Toc49798643][bookmark: _Toc52289368][bookmark: _Toc52291024][bookmark: _Toc57986851]Pearson Accessibility Guidelines
Accessibility guidelines are available for different technologies, such as web, software, PDF, Videos etc. When it comes to web content the universal guidelines all countries and companies follow is the Web Content Accessibility Guidelines (WCAG). This is true to Pearson as well. Pearson Accessibility Guidelines are aligned with the latest version of WCAG, i.e. WCAG 2.1 at Level AA.
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WCAG 2.1 was published on 5th June 2018.  Web Content Accessibility Guidelines (WCAG) 2.1 are developed by the World Wide Web Consortium (W3C) Web Accessibility Initiative (WAI) group to help individuals, companies, and governments across the globe to implement accessibility in their web content. 
The Web Content Accessibility Guidelines provide directions for making the web content more accessible for users with different types of disabilities. 
WCAG 2.1 comprises of 13 guidelines that are organized under 4 principles: 
1. Perceivable - Information and user interface components must be presentable to users in ways they can perceive. 
0. Text Alternatives: Provide text alternatives for any non-text content so that it can be changed into other forms people need, such as large print, braille, speech, symbols, or simpler language. 
0. Time-based Media: Provide alternatives for time-based media. 
0. Adaptable: Create content that can be presented in different ways (For example, simpler layout) without losing information or structure. 
0. Distinguishable: Make it easier for users to see and hear content including separating foreground from background.  
1. Operable - User interface components and navigation must be operable. 
1. Keyboard Accessible: Make all functionality available from a keyboard. 
1. Enough Time: Provide users enough time to read and use content.  
1. Seizures: Do not design content in a way that is known to cause seizures. 
1. Navigable: Provide ways to help users navigate, find content, and determine where they are. 
1. Input Modalities
1. Understandable - Information and the operation of user interface must be understandable. 
2. Readable: Make text content readable and understandable. 
2. Predictable: Make Web pages appear and operate in predictable ways.
2. Input Assistance: Help users avoid and correct mistakes.
1. Robust - Content must be robust enough that it can be interpreted reliably by a wide variety of user agents, including assistive technologies.
4.1. Compatible: Maximize compatibility with current and future user agents, including assistive technologies.
Each guideline has testable success criteria for conformance at Level A, Level AA or Level AAA. In all, there are 78 success criteria that are grouped under the above-mentioned 13 guidelines. Often the questions that come up include: Do we have to comply with all the 78 success criteria for PDF accessibility as well? What is acceptable? How much is enough? 
Below is a brief explanation of WCAG conformance levels:
Level A - Must be done
Level AA - Should be done
Level AAA - Can be done
Across the world, Level AA conformance is what organizations and governments aim to achieve. WCAG 2.0 is approved as an ISO standard: ISO/IEC 40500:2012. WCAG 2.1 is an extension of WCAG 2.0 and it includes all the success criteria’s that were part of WCAG 2.0. 
All Pearson PDF documents must satisfy WCAG 2.1 Level A and Level AA success criteria. Some of the WCAG 2.1 success criteria that are not applicable for PDF documents include: 
2.1.4, 2.5.1, 2.5.2, 2.5.4 at Level A and 
1.3.5, 1.4.12, 1.4.13, 2.4.5, 2.4.7, 4.1.3 at Level AA.

[bookmark: _Toc495952650]

[bookmark: _Toc495952653][bookmark: _Toc57986853]IMAGES
Images are used in a PDF document to convey information as well as enhance the visual presentation of the document. Descriptions need to be provided for images to make the information available for all users, including users with vision disabilities, users with learning disabilities etc. Alternate text must be specified for each informative image in a PDF document whereas decorative images must be tagged as artifacts. 
A screen reader reads out the alternate text specified for the image and skips pass the decorative images. In a PDF document, there are mainly two types of images:
· Informative images: used to display logos, graphs, diagrams etc.
· Decorative images: used to display separator lines, background images etc. 

[image: ]
 1.1.1 Non-text Content								Level A
All non-text content that is presented to the user has a text alternative that serves the equivalent purpose.

1.4.5 Images of Text									Level AA
If the technologies being used can achieve the visual presentation, text is used to convey information rather than images of text except for the following: 
Customizable: The image of text can be visually customized to the user's requirements.
Essential: A particular presentation of text is essential to the information being conveyed.


[bookmark: _Toc57986854]Types of Images
Images are classified depending on the function they serve and the information they contain. These images must have text alternatives that describe the information or function represented by them.   
The types of images are:
1. Informative Images
2. Decorative Images
3. Complex Images
4. Layered Images
5. Images of text
[bookmark: _Toc57986855]Alternate text for Images
Images are not accessible by users of screen readers and hence it is important to describe the images to them. All images which visually represent some information, typically pictures, photos and illustrations are informative images. These images need to have a text alternative that should be a short description conveying the essential information presented by the image. 

[bookmark: _Toc495952654][bookmark: _Toc57986856]Informative Images
Informative images are those images that visually represent some information, typically pictures, photos and illustrations. They need to have a text alternative that should be a short description conveying the essential information presented by the image.
[image: ]	Comment by AnnMarie Short: Make all W3C images this size. 
	WCAG Success Criteria
	WCAG Conformance Level

	1.1.1 Non-text Content 
	A


How to implement?
This section lists the techniques that need to be implemented to make images accessible in a PDF document. 
· Add alternate text that describes the information conveyed by the image.
· Include the alt-text for informative images via “alternate text” field of the <Figure> tag.
· Edit the alternate text if it fails to sufficiently describe the purpose of the image.  
· Add unique, concise, and accurate alternate text for informative images.
· Include information that describes the purpose of the image and do not describe the visual presentation of the image. 
Practices to Apply & Avoid
Avoid tagging informative images as artifacts.

For example, in the 2019-ar.pdf, empty alt attribute was provided for the Business Fights poverty logo. As a result, screen reader users will skip the image, and the purpose of the image will not be clear for screen reader users.

[image: Informative image inaccurately marked as artifact.]



Specify accurate text alternatives describing the purpose of informative images.

For example, in the 2020-Roles-and-Responsibilites-of-the-chair.pdf, accurate alternate text “Pearson Logo" is specified for an informative image.

[image: Informative image with accurate alternate text.]

Avoid specifying inaccurate and incomplete alternative text for images.
For example, in the 2019-ar.pdf, inaccurate and incomplete alternate text “The best employers for diversity" is provided for an informative image. 

[image: Image with inaccurate and incomplete alternative text.]
Add descriptive alternate text for informative images.

For example, in the 2019-ar.pdf, accurate and descriptive alternate text “Forbes 2020- The best Employers for Diversity" is provided for an informative image. 
[image: Image with accurate and descriptive alternative text.]

Avoid specifying identical alternate text for multiple images.
For example, in the 20200512_VigeoEiris_SPO_Pearson_Update.pdf, non-descriptive and identical alternate text “Icon" has been specified for multiple images.
[image: Alternative text "Icon" specified for image]

[image: Alternative text "Icon" specified for image]

[bookmark: _Toc495952655][bookmark: _Toc57986857]Decorative Images
Decorative images are used to enhance the presentation of a PDF document. Since these images do not convey any information, a descriptive alternate text is not required to be specified. 

How to implement?
This section lists the techniques for implementing decorative images in a PDF document.
· Tag decorative images as an artifact.
· Tag informative images as an artifact if the information is available in the surrounding text. 

Practices to Apply & Avoid
Ensure decorative images are tagged using artifact tag.

For example, in the 2019-ar.pdf, the following decorative image is accurately tagged as an artifact. 
[image: Decorative image accurately tagged as an artifact.]
Ensure decorative images are tagged as artifacts

For example, in the 2019-ar.pdf, the decorative image is tagged as an artifact.

[image: Decorative image tagged as an artifact. ]
Avoid specifying alternate text for decorative images.
For example, in the 2019.ar.pdf, alternate text " Young female with headphones on studying with an iPad" is specified for a decorative image. 

[image: Decorative image with alternate text specified]


[bookmark: _Toc57986858]Graphs, Charts and Diagrams
Complex images, such as graphs, diagrams, and charts, require detail description of the data or information provided in the image as the text alternative, to enable users with vision disabilities to interpret the information. Similarly, users with learning disabilities may find the complex charts, diagrams, graphs difficult to understand. Textual description in the surrounding text or a tabular representation of the graph or chart makes it easier for them to access the information.

How to implement?
This section lists the techniques that are required for making complex images, charts, and diagrams accessible.
· Add a detailed description for charts, graphs, and diagrams via the alternate text.
· Add a brief alternate text for the charts, graphs and diagrams via the alternate text and include detailed description in the surrounding text:
· Include a data table that describes the information conveyed using charts and graphs.
· Include detailed description for diagrams in the form of running text besides the image.
Practices to Apply & Avoid
Avoid using complex images such as charts and diagrams that lack textual descriptions. 
For example, in the 2019-ar.pdf file, the following graph showing the “Adjusted earnings per share” does not have an alternate text. 
[image: Graph with missing alternate text. ]
Ensure all graphs and diagrams have detailed description specified via the alternate text. 

For example, in the M05_NURS6803_03_SE_C05_MM.pdf file, diagram of the urinary tract has an alternative text labeled “Anatomical structure of the urinary tract”.
[image: Diagram with an appropriate alternate text.]

[bookmark: _Toc57986859]Layered Images
Layered images are often used in PDF documents to form a big picture. The picture comprises of multiple layers of images which are identified as separate images by assistive technologies. Even though visually these layered images form a single image they are not rendered as a single image by assistive technologies.
Screen reader users often find it difficult to interpret the information conveyed using layered images as the information is broken into pieces. These layered images should be identified as a single image for screen reader users as well. This can be achieved by grouping this layered image and specifying accurate textual information to make it easier for users to comprehend the purpose of the image. 
How to implement?
This section lists the techniques for tagging layered images to make them accessible for screen reader users.
· Group the layered images as a single image in the original source file. 
· Tag the layered images as a single image and specify descriptive alternate text for it.
· Tag the decorative layers as artifact. 
Practices to Apply & Avoid
Do not leave empty alternate text option for Layered images.
For example, in the M05_NURS6803_03_SE_C05_MM.pdf, alternate text for the following image is missing. 

[image: Layered image with missing alternate text.]
Ensure to group all the layers of the image together. 

For example, in the M05_NURS6803_03_SE_C05_MM.pdf, different layers of the following image are grouped.

[image: Layers of an image group together.]
Ensure that the document does not have layered images which are not grouped. 
For example, in the M05_NURS6803_03_SE_C05_MM.pdf, the layers of the following image are not grouped.

[image: Layers of the image are not grouped.]

User Groups Affected
· Blind Users
· Low-vision users

How to test for Accessibility?
To test images in a PDF document for accessibility, perform the following steps:
1. Open the document that needs to be tested in Acrobat Professional.
2. Check if alternate text specified for informative images is descriptive. This can be checked by:
a. Right clicking the figure tag in the Tags Panel and reviewing the alternate text field. 
b. Navigate to each informative image in the document with screen reader running. Listen if the alternate text sufficiently describes the image’s purpose.
3. Check if all decorative images are tagged as artifacts.
4. Check if detailed descriptions are specified for complex images.
5. Check if layered images in the document are grouped.
6. If any of the conditions mentioned in step 2 to step 5 fails than it is an accessibility violation as per WCAG 2.1 success criteria 1.1.1 at Level A.
[bookmark: _Toc57986860]Images of text
Text is created as an image to enhance the visual appearance of a page. Text, when created as an image, becomes pixelated when zoomed in. This makes it difficult for low-vision users and elderly users to read the text. 
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.4.5 Images of Text
	AA


How to implement?
This section lists the techniques for implement images of text in an accessible PDF document.
· Use plain text to present information rather than images of text.
· Use font formatting and color to enhance the visual appearance and achieve the desired presentation.
Practices to Apply & Avoid
Include information using plain text instead of image of text.

For example, in the 2019-ar.pdf, plain text is used instead of an image.
[image: Plain text used to convey information.]
Avoid using images of text to display important information.
For example, in the Pearson-Indicative-allocation-and-impact-reporting-template-Final-v3.pdf, image of text is used for displaying "reporting template".

[image: Text created as an image.]
User Groups Affected
· Blind Users
· Low-vision users
· Users with learning disabilities

How to test for Accessibility?
To test a document for images of text, perform the following steps:
1. Open the PDF file in Adobe Acrobat DC. 
2. Open the tags section. 
3. Using the selection tool, select the content.
4. Find this content in the tag panel using “Find from selection” option.
5. Check if the text provided over an image is implemented as plain text and not an image.
6. If the conditions in step 5 fails, then it is an accessibility violation as per WCAG 2.1 success criteria 1.4.5 at Level AA.  



[bookmark: _Toc57986861]COLOR
Color is a key component of any document. Color should be used wisely to ensure that all users including those with color blindness, low vision and blind users can access the information. While using color, three important aspects should be taken into consideration: 
· Color should not be used as the sole means to convey important information 
· Sufficient contrast should be present between foreground text and its background. 
· Sufficient contrast should be present for key graphical objects with the adjacent content
 
Color when used as the sole means to convey important information makes it difficult for users with visual impairments, such as color blindness, low vision, blind and deaf-blind users who find it difficult to understand the information. For example, key values of a table are indicated with change in color or items of a graph are distinguished using color. In such situations it becomes difficult for users with visual impairments to interpret and access the information.  
Color contrast between foreground text and its background should be sufficient to ensure that users with different types of colorblindness can access the information. Users with colorblindness, such as Protanopia, Tritanopia, Deuteranopia and monochromacy find it difficult to distinguish between certain color combinations. Thus, it is essential that sufficient contrast is present between foreground text and its background. Color contrast should be sufficient for all the important elements of a PDF document, such as text, headings, form controls, tables, informative images etc. If the color contrast is not sufficient, the information will not be legible for low vision users and colorblind users.  

[image: ]
1.4.1 Use of Color									Level A
Color is not used as the only visual means of conveying information, indicating an action, prompting a response, or distinguishing a visual element.

1.4.3 Contrast (Minimum)								Level AA
The visual presentation of text and images of text has a contrast ratio of at least 4.5:1, except for the following:
Large Text: Large scale text and images of large-scale text has a contrast ratio of at least 3:1.
Incidental: Text or images of text that are a part of inactive user interface component, that are pure decoration, that are not visible to anyone, or that are a part of a picture that contains significant other visual content, have no contrast requirement;
Logotypes: Text that is a part of a logo or brand name has no contrast requirement.

1.4.11 Non-text Contrast								Level AA
The visual presentation of the following have a contrast ratio of at least 3:1 against adjacent color(s):
User Interface Components
Visual information required to identify user interface components and states, except for inactive components or where the appearance of the component is determined by the user agent and not modified by the author;
Graphical Objects
Parts of graphics required to understand the content, except when a particular presentation of graphics is essential to the information being conveyed. 

[bookmark: _Toc57986862]Use Color wisely
Colors should be used wisely in documents, as information conveyed with color alone might not be available for people with visual disabilities. Color is a key component of any document and this is true for digital documents as well. However, information when conveyed using color alone can make it difficult for people with visual disabilities to access it. For example, in a sales graph red color lines are used to indicate dip in sales whereas green color lines are used to indicate increase in company’s sales. Ever thought how would a blind person perceive such information conveyed only with color?
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.4.1 Use of color 
	A


How to implement?
This section lists the techniques that need to be implemented to ensure that information conveyed using color is available for all users:
· Supplement color with visual clues. 
· Add text clues along with color to convey important information.
· Add patterns, symbols etc. along with color to convey important information.

Practices to Apply & Avoid
Avoid using color alone to indicate information.
For example, in the cbcc9-guided-reading-ch16.pdf, color alone is used to indicate information such as classification of protist, where “yellow” indicates “eukaryote supergroups”, “purple” indicates “protist clades” and “pink” indicates “nonprotist clades”.
[image: Color alone "Yellow", "Purple" and "Pink" are used to indicate information.]

Provide textual clues along with color.

For example, in the 2019-ar.pdf, data for Contribution in 2019 is indicated by color as well as through supporting text.
[image: Contribution in 2019 is indicated by both color and text.]

Do not use color alone to indicate data in graphs. 
For example, in the 2019-ar.pdf, color alone “blue” and “green” is used to indicate digital penetration and decline in print revenue percentage over the years in a line graph.

[image: Color alone “blue” and “green” is used to indicate digital penetration and decline in print revenue percentage over the years in a line graph.]
Ensure to supplement color with other visual elements such as patterns, varying line styles or symbols to indicate data in graphs and charts.  

User Groups Affected
When color alone is used to convey important information, the user group that gets largely affected is users with visual disabilities such as:
Color-blind users (with protanopia, deuteranopia, tritanopia etc.)
Low-vision users
Blind users
How to test for Accessibility?
To test a PDF document for use of color alone to convey important information, perform the following steps:
1. Open the PDF document that needs to be tested.
2. Check on different pages if color is used to convey important information.
3. Check if color is supplemented with text or other visual clues to convey the information. 
4. If the condition in step 2 is true and step 3 is false, then it is an accessibility violation as per WCAG 2.1 success criteria 4.1.1 at Level A.

[bookmark: _Toc57986863]Color Contrast
Colors used for displaying text and images of text (text created as an image) should have sufficient contrast with their background to make the information legible for users. 
Color blindness is the inability to perceive differences between some colors. Users who are color blind have difficulty in differentiating color or between red and green, or blue and yellow. 
Ensuring a PDF document follows the WCAG guidelines for color contrast ratio, color should not affect a person’s ability to perceive important content.

Types of color blindness:
· Tritanopia: makes it hard to tell the difference between blue and green, and between yellow and red.
· Protanopia: makes red look greener and less bright.
· Deuteranopia: most common type of red-green color blindness. It makes green look more red.
· Monochromacy: cannot see color at all (gray scale).

[image: Screenshot of Color contrast analyser (CCA) with contrast ratio of 7.8:1 for Normal vision, 7.5:1 for Protanopia, 8.4:1 for Deuteranopia, 7.8:1 for Tritanopia]
How to implement?
This section lists the techniques to ensure that color contrast used in a PDF document is sufficient. 
For text:
For standard text (font lesser than 14pt) to be readable, it is mandatory for it to have a color contrast of 4.5:1 with its background. 
· For large text (14pt bold or 18pt) to be readable, it is mandatory for it to have a color contrast of 3:1 with its background. 
· There are exceptions. Incidental texts which are not required to meet the contrast requirements are: an inactive user interface element, logo, text for pure decoration, text with is not visible to anyone.

Non-Text:
For non-text elements such as user interface components and graphical objects, it is mandatory for the contrast ratio to be above 3:1 with its adjacent color. 
· User interface components are the controls for different functions. These controls in their different states such as active, hover etc. should have a contrast ratio higher than 3:1 with their background. Non-text contrast requirements are not applicable if the user interface components are in an inactive state. They are also not applicable to visual borders that are added by the user agent when a link or any other interactive element receives focus. 
· Graphical objects are those elements that convey important information, such as graphs, diagrams, key icons etc.  Non-text contrast requirements are applicable to images that convey important information and different components of the graphical object need to have minimum contrast of 3:1. Elements can be excluded from the non-text contrast requirements if changing the contrast will result in incorrect interpretation of information.
· Colors used for displaying text and images of text (text created as an image) should have sufficient contrast with their background to make the information legible for users.
[bookmark: _Toc57986864]Contrast for Text Content
Colors used for displaying text and images of text (text created as an image) should have sufficient contrast with their background to make the information legible for users.

[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.4.3 Contrast (Minimum)
	AA


How to implement?
This section lists the techniques that need to be implemented to ensure that contrast between the foreground text is sufficient with its background in different scenarios.
· Two colors are considered to have good visibility if the contrast ratio between the foreground text and background is sufficient. Darken either the foreground or the background color to ensure that it passes the contrast requirement outlined by WCAG 2.1.  
· Check the contrast ratio between foreground text colors with the background using color contrast testing tools before using them in a PDF file. The minimum contrast requirements outlined by WCAG 2.1 are: 

	Text Size 
	Contrast Ratio 

	Standard size text (anything less than 14pt) 
	4.5:1 

	Large-size text (14pt bold or 18pt) 
	3:1 



Authors should check for color contrast before authoring PDF documents to ensure that sufficient color contrast is present for textual content including images of text. Once the document is authored, it becomes difficult to retrofit it for color contrast at a later date. 
To adjust color contrast for text using Acrobat Professional, one has to use an older version of Acrobat Professional to achieve it. Moreover, only text colors can be adjusted and not for images, so it is very crucial to check for color contrast during authoring PDF documents. 

Adjusting color contrast through Acrobat Professional!
Following steps should be performed to adjust color contrast for text using Acrobat Professional:
1. Open the pdf file using Adobe Acrobat 8 Professional.
2. Select the edit tool from the properties bar. 
3. Select the “Touch Up Text Tool”.
4. Select the text whose color needs to be changed and right click to click on properties
5. In touch up properties, within the text tab, click on “fill” and select an appropriate color.  
6. Clicking on close will apply the changes and the color will be adjusted.

[image: TouchUp Properties tool to change the text color with "Fill" option within text tab highlighted.]

Practices to Apply & Avoid
Use colors that provide sufficient contrast between the foreground text and background.

For example, in the 2020-Chief-Executives-strategic-overview.pdf, sufficient color contrast is used for displaying the texts "Legacy". The color contrast ratio "10.3:1" is used for displaying the text.
[image: Sufficient color contrast for the text "Legacy".]
[image: Color contrast analyser (CCA) showing contrast ratio of 10.3:1 for the text "Legacy"]
Color contrast between the foreground and background of less than 4.5:1 should not be used for displaying standard size text. 
For example, in the 20200512_VigeoEiris_SPO_Pearson_Update.pdf, color contrast for the text "Advanced" is 1.4:1.   
[image: Insufficient color contrast is used for the text "Advance".]

[image: Color contrast analyser (CCA) showing contrast ratio of 1.4:1 for the text "Advance"]

User Groups Affected
When insufficient color contrast is used, the user group that gets largely affected is users with visual disabilities such as:
Color-blind users (with protanopia, deuteranopia, tritanopia etc.)
Low-vision users

How to test for Accessibility?
To check the color contrast for text, perform the following steps:  
1. Open Color Contrast Analyser (CCA).  
2. Open the page for which color contrast of text needs to be checked.  
3. Using the eye dropper tool, pick the hex code of the text’s foreground color as well as the hex code of the background color.  
4. Add the foreground text and background color hex codes in the respective text fields available in CCA.  
5. Color contrast ratio along with its conformance result will be displayed. Conformance will be displayed for:  
a. Standard text size and large text size  
b. Results are displayed for Level AA as well as Level AAA.  
6. Text or images of text that are part of an inactive user interface component, that are pure decoration, that is not visible to anyone, or that are part of a picture that contains significant other visual content, have no contrast requirement.  
7. Text that is part of a logo or brand name has no contrast requirement. 
8. If the color contrast ratio is less than 4.5:1 for standard text or less than 3:1 for large text, then it is an accessibility violation of WCAG 2.1 success criteria 1.4.3 at Level AA. 

[bookmark: _Toc57986865]Contrast for Non-Text Content 
Color contrast needs to be enough not only for textual content available in PDF documents but also for all the important non-textual content. The contrast between non-textual content with the adjacent color needs to be 3:1.  

Non-text contrast requirements were introduced in WCAG 2.1 and is applicable to: 
User interface controls in different states, such as focus, active, hover, etc. This applies to different user interface components, such as links, form controls, buttons, etc. For example, if the background color of a link changes on focus then the contrast between the link's background color with the text font as well as the page's background color should be at least 3:1. Non-text contrast requirements are not applicable if the user interfaces components in an inactive state. Similarly, non-text contrast requirements do not apply to visual borders that are added by the user agent when a link or any other interactive element receives focus. 
Graphical objects that convey important information, such as graphs, diagrams, key icons, etc.  Non-text contrast requirements are applicable to images that convey important information and different components need to have minimum contrast of 3:1, such as lines of a line graph, labels of a bar graph, key icons, numerical and textual data of complex diagrams, etc. However, if changing the contrast will result in an incorrect interpretation of information, i.e. changes the meaning of the subject then those graphics do not need to adhere to the above-mentioned contrast requirements. For example, in the case of science experiments, if by changing the contrast will result in changing the meaning of the topic being explained, then such graphics do not need to adhere to the above-mentioned contrast requirements.  
The above requirements were introduced to ensure that low vision users can access all the important information conveyed using non-text content. 

[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.4.11 Non-text Contrast
	AA


How to implement?
This section lists the techniques that need to be implemented to ensure sufficient contrast for non-text content in different scenarios.
Check the contrast ratio of the graphical object and its surrounding using color contrast testing tools before using them in a PDF file.
Two colors are considered to have good visibility if the contrast ratio between the graphical object and its surrounding is enough. Darken either the graphical object or the background color to ensure that it passes the contrast requirement outlined by WCAG 2.1. 
Practices to Apply & Avoid
Color contrast for non-text content should not be less than 3:1. 
For example, in the 2020-Chief-Executives-strategic-overview.pdf, color contrast fails for the progress bar and is 1.3:1.   

[image: Insufficient color contrast for the progress bar.]
[image: Color contrast analyser (CCA) showing contrast ratio of 1.3:1 for the non-text element.]
Ensure color contrast is above 3:1 for all non-text elements. 

For example, in the 2019-ar.pdf, a graph indicating revenue and underlying revenue in 2019 with sufficient color contrast for North American Courseware of 13.3:1 and International of 7.0:1 is found.   
[image: Graph indicating revenue and underlying revenue in 2019 with sufficient color contrast for North American Courseware of 13.3:1 and International of 7.0:1.]


User Groups Affected  
When insufficient color contrast is used, the user group that gets largely affected is users with visual disabilities such as:  
· Color-blind users (with protanopia, deuteranopia, tritanopia etc.) 
· Low-vision users 

How to test for Accessibility?
To check the color contrast for non-text content, perform the following steps:  

1. Open Color Contrast Analyser (CCA).  
2. Open the page for which the color contrast of non-text content needs to be checked.
3. Use the picker to select the color of the graphical object and its surrounding.  
4. Color contrast ratio along with its conformance result will be displayed. 
5. If the color contrast ratio is less than 3.0:1 then it is an accessibility violation of WCAG 2.1 success criteria 1.4.11 at Level AA. 


[bookmark: _Toc57986866]HEADINGS
Headings act as a title for key sections of a PDF document. Headings are defined for the main section as well as sub-sections of the document. Headings form an outline that identifies key sections of a document. They depict the hierarchy of a document’s content structure.
Headings allow screen reader users to skim through the content of the document and access the required content quickly. Headings also act as a base for defining document bookmarks. Descriptive heading text help users to understand what content will be available in each section of the document. 
[image: ]
1.3.1 Info and Relationships								Level A
Information, structure, and relationships conveyed through presentation can be programmatically determined or are available in text
2.4.1 Bypass Blocks								  	Level A
A mechanism is available to bypass blocks of content that are repeated on multiple webpages.
2.4.6 Headings and Labels								  Level AA
A Headings and labels describe topic or purpose.

[bookmark: _Toc57986867]Heading Structure
Headings are used to define the content structure of a document. Sections and sub-sections of a document are tagged using heading level tags. Like HTML, there are six heading levels Heading Level 1 - Heading Level 6 in a PDF document. 
Assistive technologies can identify the headings based on the tags and provide users with an option to understand the content structure as well as navigate quickly to different parts of a document.
Heading levels should be defined in a manner that they depict the content hierarchy of the document. Heading levels should not be skipped, i.e. <H5> should not be used directly to tag the main topic or section as the first heading in the document. If the PDF document is a book, the name/title of the book should be tagged as <H1>. All the chapter titles should be tagged as <H2> and sub-topics within the chapter should be tagged as <H3>, <H4>, <H5> and <H6> depending on the content of the book. 
Headings should be used in a sequence and must not be skipped but at the same time they should be tagged consistently. So if in a document the sub-topics of the chapter go up to <H4> and then the next chapter starts , it is acceptable in such a scenario to break the sequence and tag the chapter title using <H2>. 
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.1 Info and Relationships

	A

	2.4.1 Bypass Blocks 
	A


How to implement?
This section lists the techniques that need to be implemented to ensure visual headings are tagged as Headings.
· Avoid the use of only formatting styles such as font size, underline, bold etc. to present headings.
· Use PDF heading tags to define the document structure.
· Use headings in the correct sequence:
· <H1> should be followed by <H2>
· <H2> should be followed by <H3> and so on
· It is a best practice to have only one <H1> for a document that is indicative of the core content of the PDF file. However, if <H1> is used to tag main title of each section within a document then it is an acceptable as long as it has been followed consistently!
Note: Remove all empty heading tags from the document, as it gives a false impression to screen reader users that some information is not being read out for them.
· Define the outline of the content by providing short headings to group related content.

Tip: 
Images, such as logos can be tagged as H1 of a PDF documents that do not have any textual heading.   
Practices to Apply & Avoid
Heading should only be defined for the text that constitutes as a heading for a section or subsection on a page.

For example, in the 2020-LTIP-target-disclosure-FINAL.pdf, the heading “Allocation reporting” is appropriately defined as <H3>.
[image: Heading appropriately marked with the <H3> tag.]
Avoid tagging content that does not constitute as a heading using heading tags.
For example, in the 2020-LTIP-target-disclosure-FINAL.pdf, the date of the document “18 September 2020” content is incorrectly defined as <H1>. 
[image: Content incorrectly marked using the <H1> tag.]

Use heading tags such as <H1>-<H6> to define headings in a document.

Avoid skipping heading levels. 
For example, in the 2020RemunerationPolicy.pdf, the heading text such as “Aligned to longer-term strategy” is defined as heading level 3 (<H3>) instead of heading level 2 (<H2>) in the main content area.

[image: Heading level 2 inaccurately tagged using the <H3> tag. ]
Avoid using only visual formatting to define headings in a document.
For example, in the 2020-LTIP-target-disclosure-FINAL.pdf, the text “Long-Term Incentive Plan (LTIP)" visually appears as a heading but is not tagged using heading tag. Instead, visual formatting alone is used to present it as a heading
[image: Heading presented using visual formatting alone.]
Avoid using multiple <H1> headings in a document.
For example, in the FINAL-RNS-200918_Results_of_General_Meeting.pdf, there are multiple <H1> heading tags. 

[image: Use of multiple <H1> tags in a document. ]


How to test for Accessibility?
To test for document’s headings, perform the following steps:
1. Open the document that needs to be reviewed for heading structure using Acrobat Professional. 
2. Select the headings and check the heading tag assigned to it by opening the Tags panel. 
3. If the heading tag does not match with the content hierarchy of the document, then it is an accessibility violation as per WCAG 2.1 success criteria 2.4.10 at Level AAA.
4. If the heading is not tagged using appropriate heading tag, then it is an accessibility violation as per WCAG 2.1 success criteria 1.3.1 at Level A.

Tip:
Check heading structure of a document with screen reader running to get quick and reliable results.


[bookmark: _Toc57986868]Heading Text
Heading text should be unique, clear, descriptive, and consistent across pages of a document. This helps users in understanding what content will be available below the given heading, and users can easily find the information they are looking for. 
Tip: 
Descriptive heading text helps screen reader users to skim through the document and quickly access the required content. 

[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	2.4.6 Headings and Labels 
	AA


How to implement?
This section lists the techniques that need to be implemented to ensure heading text of a document is descriptive.
· Use heading text that is descriptive of the section’s content.
· Use unique heading text for each section and sub-section of a document. 
· Use a single heading tag to present heading text split across multiple lines. If there are two tags present in the Content Panel of the document, then move the text inside a single tag and delete the other tag from the Contents Panel. 

Tip:
Include the heading text within Actual text of the respective heading tag if the heading text is split visually but does not have multiple tags in the Contents Panel. 

Practices to Apply & Avoid

Ensure descriptive heading text is used for each section and sub-section of a document.

For example, in Pearson-Social-Bond-Brochure_Accessible.pdf, the heading text “2020 Sustainability Plan” is descriptive about the section’s content. 

[image: Descriptive heading text for a section.]

Avoid splitting heading text into multiple heading tags. 
For example, in the Pearson-Social-Bond-Brochure_Accessible.pdf, the heading “Pearson’s Responsible Business Leadership Council (RBLC)” is split into two heading tags - “Pearson’s Responsible Business” and “Leadership Council (RBLC)”. This will result in two headings announced for screen reader users. 
[image: Heading text split in two tags.]

Ensure Heading text is in one tag. 

For example, in the Pearson-Social-Bond-Brochure_Accessible.pdf, the heading text “Taking stock of our 2020 plan” is within a single <H2> tag.
[image: Heading text tagged appropriately within one <H2> tag. ]
User Groups Affected
· Blind users
· Low-vision Users
· Users with learning disabilities

How to test for Accessibility?
To test for a document’s heading text, perform the following steps:
1. Open the PDF document that needs to be tested in Adobe Reader. 
2. Turn on either JAWS or NVDA.
3. Press “H” to jump to the next heading and “Shift + H” to jump back to the previous heading. 
4. Press “Insert + F6” to access the list of headings using JAWS or “Insert + F7” to access the list of headings using NVDA. 
5. Check if any heading tag is split into multiple tags.
6. Check if heading text sufficiently describes the content of each section. 
7. If the conditions in step 5 and 6 are true, then it is an accessibility violation as per WCAG 2.1 success criteria 2.4.6 at Level AA.


[bookmark: _Toc57986869]LISTS
In a PDF document, there are three main types of lists: ordered list, unordered list and nested list. An ordered list is used to group sequential items, an unordered list to group related but non-sequential items whereas a nested list is a list within a list. A nested list can be used for both ordered and unordered lists. 
Lists, when tagged correctly, are identified by screen readers as lists and nested lists. A screen reader informs users about the list's beginning and end, number of items in the list, and their nesting levels. This helps users interpret the related data.
Screen readers do not identify type of a list for their users. Users can identify type of list on the basis of the list item prefix, such as “1, 2, 3 … “and “bullet character, hyphens, asterisk character … “ etc.
[image: ]
1.3.1 Info and Relationships								Level A
Information, structure, and relationships conveyed through presentation can be programmatically determined or are available in text
[bookmark: _Toc57986870]
Ordered Lists
An ordered list is used to group sequential items. In PDF documents, an ordered list is commonly used to present list of form instructions, steps to perform an exercise, steps that are part of how to guides etc. 
 
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.1 Info and Relationships 
	A


How to implement?
This section lists the techniques that need to be implemented to tag ordered lists.
· Use the standard 4 tags to present ordered lists:
· <L> that acts as a container for all the list items;
· <LI> that is used to present individual list items;
· <Lbl> to wrap the list item prefix;
· <LBody> to present content of individual list items.
· include <Lbl> and <LBody> tags under a single <LI> tag and do not use them in separate <LI> tags.
· Ensure empty <LI> tags are not present in the document.

Practices to Apply & Avoid
Use tags, such as List (<L>), List Items (<LI>), Label <Lbl> and List item Body <LBody> to structure a list.

For example, in the 2020-Schedule-of-Matters.pdf, list tags are accurately used to present related information such as “1. Responsibility for the overall leadership of the company and setting the company’s purpose, values, and standards…” and “2. Determining the company’s strategy in consultation…” etc. 

[image: Ordered list structured correctly using <L>, <Li>, <Lbl> and <LBody> tags.]

Do not group related items only by visually placing them together.
For example, in the M05_NURS6803_03_SE_C05_MM.pdf, the ordered list of “1. Identify the functional unit…..”, “2. A patient is prescribed a medication….” And “3. On the basis of the anatomy….” Is tagged in accurately using the <P> tag. 
[image: Ordered list inaccurately tagged using the <P> tag. ]


Avoid skipping any list tag element to structure a list.
For example, in the 2020-Governance.pdf, the ordered list has a missing Label <Lbl> tag.

[image: Ordered list with missing <Lbl> tag]

[bookmark: _Toc57986871]Unordered Lists
Unordered lists are used to group non-sequential related items. Examples of unordered lists in a PDF document include related content below points to remember in a book, list of company’s offices in an Annual Report, services that a company offers in their sales brochure etc. 
 
How to implement?
This section lists the techniques that need to be implemented to tag unordered lists. 
· Use the standard 4 tags to tag unordered lists:
· <L> that acts as a container for all the list items;
· <LI> that is used to present individual list items;
· <Lbl> to wrap the list item prefix;
· <LBody> to present content of individual list items.
· include <Lbl> and <LBody> tags under a single <LI> tag and do not use them in separate <LI> tags.
· Ensure empty <LI> tags are not present in the document.
Tip: 
Specify actual text for <Lbl> tag to inform screen reader users about list item prefix (“bullets”) if the document’s font is not rendered appropriately for the list item prefix character.

Practices to Apply & Avoid
Use tags, such as List (<L>), List Items (<LI>), Label <Lbl> and List item Body <LBody> to structure an unordered list.

For example, in the 2020-Roles-and-Responsibilites-of-the-Chair.pdf, list tag is accurately used to specify related information such as “Upholding the highest standard of integrity…” and “setting the agenda, style and tone of board….”
[image: Unordered list structured correctly using <L>, <Li>, <Lbl> and <LBody> tags.]

Do not group related items only by visually placing them together.
For example, in the 2020-Governance.pdf, related items are placed together but not structured using List (<L>), List Items (<LI>), Label <Lbl> and List Item Body <LBody> tags.

[image: Unordered list not structured using the appropriate list tags. ]

Avoid using formatting effects to create lists. 
For example, in the 2020-Governance.pdf, the unordered list of “The audio committee……”, “Pearson’s Executive and leadership….” etc. is inaccurately grouped together using the <P> tag. 

[image: Unordered list inaccurately tagged using the <P> tag. ]
Avoid skipping any list tag required to structure a list
For example, in the 2020-Governance.pdf, the unordered list has a missing Label <Lbl> tag.

[image: Unordered list with missing Label <lbl> tag.]

[bookmark: _Toc57986872]Nested Lists
Nested lists are lists within a list. Nested lists are used within ordered as well as unordered lists. For each nested level list, screen reader identifies the nesting level for their users which help them to access the document with ease. 
In the case of ordered lists, a nested list can either be an ordered list or an unordered list. Whereas in the case of an unordered list, it is recommended to use only unordered nested list. 

[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.1 Info and Relationships 
	A



How to implement?
This section lists the techniques for implementing nested lists in a document. 
· Use ordered or unordered lists to present nested list based on the content available in a document.
· Wrap the nested list inside <LI> tag of the parent list to convey the structure accurately to screen reader users.
· Use nested lists up to two levels to improve the reading experience for screen reader users. 

Tip: 
Screen reader users find nested lists that have more than 2 nesting levels difficult to comprehend.  

Practices to Apply & Avoid
Ensure to tag and structure nested lists appropriately using the List (<L>), List Items (<LI>), Label <Lbl> and List Item Body <LBody> tags.

For example, in the 2020-Roles-and-Responsibilities-of-the-Chair.pdf, the nested list is accurately used to tag an unordered list’s content such as “Chairing board and general meetings”, “Running the board and ensuring…”, “Setting the board agenda…” etc. within a an ordered list’s content “1. Meetings”. 
[image: Nested list structured correctly using <L>, <Li>, <Lbl> and <LBody> tags.]
Avoid omitting the <Lbl> tag 
For example, in the 2020-Roles-and-Responsibilities-of-the-Chair.pdf, in the nested list the label <Lbl> tag is missing. 
[image: Missing <Lbl> tag in the nested list.]

User Groups Affected
· Blind users
· Low-vision Users

How to test for Accessibility?
To check for accessibility of lists, perform the following steps:
1. Open the PDF file using Acrobat Professional. 
2. Open the tags panel.
3. Using the selection tool, select the list contents.
4. Find its corresponding tag from the tag section using the “find tag from selection” option that is available below the “Options” menu.
5. Ensure, the list starts with an <L> tag. 
6. Each list item should be tagged using <LI> tag and is nested within the <L> tag.
7. List item prefix should be tagged using <Lbl> tag. This tag should contain the label of the list content that is, the bullet points/numbers/ alphabets etc.
8. Content of each list item should be tagged using <LBody> tag. 
9. If the conditions in step 5 to 8 are not true for any ordered, unordered, or nested list within a document than it is an accessibility violation as per WCAG 2.1 success criteria 1.3.1 at Level A.


[bookmark: _Toc57986873]TABLES
Tables are used in a PDF document to present relational data. PDF tables allows data like text, images, links, other tables, etc. to be arranged into rows and columns of cells. Two types of tables are generally used in a PDF document: data tables and layout tables.
 [image: ]	Comment by AnnMarie Short: Missing alt text

1.3.1 Info and Relationships								Level A
Information, structure, and relationships conveyed through presentation can be programmatically determined or are available in text

1.3.2 Meaningful Sequence								Level A
When the sequence in which content is presented affects its meaning, a correct reading sequence can be programmatically determined.

[bookmark: _Toc57986874]Layout Tables
Layout tables do not represent any relationships among content. Layout tables are used to position the content in a PDF document. Authors used layout tables to position page content such as images, textual content, contact information etc. 
When layout tables are used, ensure that the content presented is linearized correctly, i.e. the order of the content should be meaningful when it is accessed in a linear order. Screen readers read a table’s content in a linear order, reading one cell at a time from left-to-right and top-to-bottom. For example, a screen reader will read the table information in the following order:
6. Column 1, row 1
7. Column 2, row 1
8. Column 3, row 1 … 
9. Column 1, row 2
10. Column 2, row 2
11. Column 3, row 2 …

Structural table tags, such as table headers (<TH>), table caption (<Caption>), table summary (”summary” property), etc., are used for conveying table structure to user agents, and they should not be used in the case of layout tables.


[image: ]	Comment by AnnMarie Short: Missing alt text
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.1 Info & Relationships

	A

	1.3.2 Meaningful Sequence
	A


How to implement?
This section lists the techniques for implementing layout tables in a PDF document:
· Tag the table borders as artifacts.
· Tag the table content in a logical reading order.
· Ensure that structural table tags are not used for displaying layout tables.

Tip: 
Layout tables in PDF documents are not identified as tables for screen reader users as they are not tagged using <Table> tag.

Practices to Apply & Avoid
Ensure structural table tag is not used for layout tables.

For example, in the 2020-Governance.pdf, the content under operation, opportunity and performance and period is accurately tagged using <H3> and <P> tags. 

[image: Content accurately tagged using the <H3> and <P> tags. ]
Avoid using table tags for formatting content presented using layout tables.
For example, in the 2020-Governance.pdf, the content under operation, opportunity and performance and period is inaccurately tagged using the <Table> tag. 

[image: Content inaccurately tagged using the <Table> tag. ]
How to test for Accessibility?
To test layout tables, present in a PDF file, perform the following steps:
1. Open the PDF file using Acrobat Professional.
2. Open the Tags Panel.
3. Select the contents of the layout table.
4. Click on “Find Tag from Selection” available below Options inside the Tags Panel.
5. Check if table borders are tagged as artifacts.
6. Check if structural table tags are not used for tagging the table’s contents.
7. Check if the reading order is meaningful.
8. If the conditions in step 5, 6 and 7 fail, then it is an accessibility violation as per WCAG 2.1 success criteria 1.3.1 and 1.3.2 at Level A.

[bookmark: _Toc57986875]Simple data Tables
Data tables are used to present related data. A data table consists of data cells and header cells. Table headers are added to provide context for users and if this contextual relationship is not exposed programmatically, it will pose accessibility barriers for people with visual disabilities.
A simple data table comprises of either single set of column headers or row headers or both column and row headers. A simple data table does not generally include merged cells but at times might include blank cells. Screen readers identify the table headers and announce them for users as they navigate through the data. 


[image: ]
	WCAG Success Criteria 
	WCAG Conformance level

	1.3.1 Info & Relationships
	A




How to implement?
This section lists the techniques that should be used for accessible implementation of simple Data Tables.
Tag table header cells using <TH> tags.
Use <TD> tag to structure blank cells. This is applicable for cells present in the first row or column of a simple data table. 
Note: An empty cell should never be tagged using <TH> tag.

Practices to Apply & Avoid
Use appropriate tags to specify table using <Table>, <TH>, <TR> and <TD> tags.

For example, in the cbcc9-guided-reading-ch16.pdf, the <Table> tag is used to tag the entire table. <TR> tag is used to tag the table column headers like- “Photoautotrophs”, “Photoheterotrophs”, “Chemoautotrophs” and “Chemoheterotrophs”. <TD> is also used to tag row headers like- Description and Example. <TD> is used to tag the empty data cells in the table. 
[image: Table tagged appropriately using the <Table>, <TH>, <TR> and <TD> tags.]
Avoid using only visual formatting to present data in a tabular format. 
For example, in the cbcc9-guided-reading-ch16.pdf, the content visually appears as a table, however it is tagged inappropriately using the <P> tag.

[image: Data table tagged incorrectly using <P> tag.]
Avoid using <TD> tags for tagging table headers. 
For example, in the 2019-ar.pdf, table headers in the table such as- “Strategic Priority”, “Measure, % of total funding” etc. are tagged using the <TD> tag. 
[image: Table headers tagged inappropriately using <td> tag.]
How to test for Accessibility?
To test a simple data table for accessibility, perform the following steps:
1. Open the PDF document that needs to be tested in Acrobat Professional.
2. Navigate to the simple data table that needs to be tested.
3. Open the Tags Panel.
4. Select the simple data table.
5. Click on “Find Tag from Selection” available below Options inside the Tags Panel.
6. Check if table headers and data cells are tagged appropriately, using <TH> and <TD> tags respectively.
7. If the condition in step 6 fails, then it is an accessibility violation as per WCAG 2.1 success criteria 1.3.1 at Level A.

[bookmark: _Toc57986876]Complex data Tables
A complex data table comprises of two or more sets of column headers, row headers or column and row headers, as well as data cells. 
Tabular data, if not coded keeping accessibility in mind, can pose accessibility issues for users with vision disabilities (who use screen readers). In fact, content presented using simple data tables can yet be understood but in the case of complex data tables, screen reader users often find it difficult to interpret the data. 
In the case of complex table along with <TH> tags, “id” needs to be specified for data cells and table header cells. This helps in explicitly defining the relationship between data cells and their headers. This explicit association is helpful for screen readers in rendering the header cells when users navigate through the table data. 
In order to make complex tables accessible, it is recommended to define the table caption and summary as well. Table caption is visible for all users whereas summary should be provided to orient users with visual impairments about how the data is organized in the table. Alternatively, complex tables can also be made accessible by breaking them in to multiple simple data tables. Simple tables are easy to comprehend by users with visual disabilities. 

[image: ]
	WCAG Success Criteria 
	WCAG Conformance level

	1.3.1 Info & Relationships
	A




How to implement?
This section lists the techniques for implementing accessible complex data tables in a PDF document.
· Define table headers using <TH> tags.
· Use row span and column span fin the case of merge columns and rows.
· Define scope for table header cells.
· Define “id” for table header and data cells to explicitly associate data and header relationship between the cells.
· Define table caption for complex data tables. 
· Define summary for complex data tables. Summary can be defined by clicking on Reading Order Tool and then right-clicking on the table and choose “Edit Table Summary”.
Practices to Apply & Avoid
Avoid specifying incorrect ColSpan or RowSpan values for complex data tables.
For example, in the Pearson-Indicative-allocation-and-impact-reporting-template-Final-v3.pdf, 4 columns are merged to present the header “Project Overview” but an inaccurate ColSpan of 1 is specified. 

[image: Incorrect Colspan value is specified for complex data table.]

Specify correct values for RowSpan and ColSpan.

For example, in the Pearson-Indicative-allocation-and-impact-reporting-template-Final-v3.pdf, 4 columns are merged for header “Allocation information” and an accurate ColSpan of 4 is specified. 

[image: Complex data table with an accurately specified ColSpan value of 4. ]
Avoid using <TD> tags to tag table headers.
For example, in the 2020-Governance.pdf, table data tag <TD> is used to incorrectly tag the table headers of “Performance measure”, “% of total”, “threshold” etc. 

[image: <TD> used to tag table headers. ]
Specify unique ID values for table headers and data cells of a complex table. 

For example, in the 2020-Governance.pdf, a unique ID attribute is used to tag table headers and cells in the complex table. 
[image: Unique ID used to tag complex data tables.  ]
Ensure to always tag table headers using the <TH> tag. 

For example, in the 2020-Governance.pdf, table header tag <TH> is used to correctly tag “Performance measure”, “% of total”, “threshold” etc. table headers.  

[image: <th> used to markup table headers. ]

User Groups Affected 
· Blind users
· Low vision users
· Deaf-blind users


How to test for Accessibility?
To check a complex data table for accessibility, perform the following steps:
1. Open the PDF document that needs to be tested using Acrobat Professional.
2. Open the Tags Panel.
3. Select the complex table and click on “Find Tag from Selection” available below “Options” inside the Tags Panel.
4. Check if header cells are tagged using <TH> tags.
5. Check if columns and rows are merged accurately.
6. Check if scope and id are defined to convey the relationship.
7. If any of the conditions in step 4, 5 and 6 fails then it is an accessibility violation as per WCAG 2.1 success criteria 1.3.1 at Level A.

The below table lists keystrokes for accessing tables using the two leading screen readers on the Windows operating system: 

	Function
	JAWS command
	NVDA command

	Go to Next Table
	T
	T

	Go to Previous Table
	Shift + T
	Shift + T

	List of Tables
	Insert + Control +T
	–

	Move to next cell
	Ctrl + Alt +Right Arrow
	Ctrl +Alt +Right Arrow

	Move to previous cell
	Ctrl + Alt+ Left Arrow
	Ctrl+ Alt+ Left Arrow

	Move Down cell
	Ctrl+ Alt+ Down Arrow
	Ctrl + Alt + Down Arrow

	Move Up cell
	Ctrl + Alt + Up Arrow
	Ctrl + Alt + Up Arrow





[bookmark: _Toc57986877]TITLE, LANGUAGE AND CONTENT
Title of a PDF document helps users especially screen reader users understand what information will be available in the document. Often authors set the file name as its title which fails to describe the file’s contents to users. Organizations have file naming conventions that authors are required to follow and by specifying descriptive file title they can adhere to the naming conventions and at the same help users understand the file’s contents easily.
Language of the PDF file’s content must be defined programmatically to ensure that user agents can render the information accurately. User agents, such as assistive technologies (screen readers and braille displayers) rely on PDF tags and properties to identify the language of a document. 
Content is king and it is equally important to make it accessible to ensure that people with disabilities can access the content. Different factors play a crucial role when it comes to making content accessible. One of such factors is expansion for abbreviations and acronyms that need to be tagged correctly so all users can interpret them correctly. PDF tags provides authors with different tags and properties for displaying abbreviated content. 
[image: ]	Comment by AnnMarie Short: Missing alt text
2.4.2 Page Titled									Level A
Web pages have titles that describe topic or purpose.
3.1.1 Language of Page								Level A
The default human language of each Web page can be programmatically determined.
[bookmark: _Hlk55379536]3.1.4 Abbreviations									Level AAA
A mechanism for identifying the expanded form or meaning of abbreviations is available.

[bookmark: _Toc57986878]Descriptive file title
Document title is the first piece of information that a screen reader reads when a PDF file is opened. Based on the title, users can understand the file’s content, as well as the file’s purpose. An appropriate document title is found very helpful by users with visual impairments who use a screen reader or screen magnifier, as it helps them understand the file’s contents. If a PDF file lacks a title or includes filename as its title, it becomes difficult for screen reader users to interpret the file’s contents. 

[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	2.4.2 Page Titled
	A


How to implement?
This section lists the techniques for adding descriptive file title for a PDF document.
· Specify descriptive title for the file by:
· Click on File>Document Properties>Description Tab>Title:
· Specify descriptive title that is indicative of the file’s contents.
·  Select “Document Title” from “Windows Option-Show” available below “Initial View”.
Tip: 
Specify <H1> text as title of the file.

Practices to Apply & Avoid
Avoid using an empty or inaccurate file title.
For example, in the 2020-LTIP-target-disclosure-FINAL.pdf, the file title is empty.
[image: PDF with empty file title.]
Ensure that the file title appropriately describe the file’s contents. 

For example, in the 2020-Roles-and-responsibilities-of-the-chair.pdf, the file has an accurate title “Role of Chair”.
[image: PDF with accurate file title "Role of Chair".]
How to test for Accessibility?
To test if descriptive title is specified for a PDF file, perform the following steps:
1. Open the PDF file that needs to be tested using Acrobat Professional.
2. Click on Document Properties > Description Tab > Title.
3. Check if descriptive title is specified in the “Title” field and “Document Title” is selected from the Initial View > Windows Option – Show.
4. If any of the condition in step 3 fails than it is an accessibility violation as per WCAG 2.1 success criteria 2.4.2 at Level A.
[bookmark: _Toc57986879]Primary Language
The document’s language must be set programmatically to ensure that assistive technologies, such as screen readers and Braille displays, can render the information in the language intended by the author. Screen readers include support for different languages and provide an option to either change the language manually or configure it to switch automatically. 

[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	3.1.1 Language of Page
	A



How to implement?
This section lists the techniques for defining primary language of a PDF document.
· Define primary language by:
· Click on File>Document Properties>Advance Tab>Reading Option>Language.
· Select required language from the drop-down or type the language code if not available in the list.

Practices to Apply & Avoid
Define the primary language of the document. 

For example, in the 2020-Roles-and-responsibilities-of-the-chair.pdf, the file has appropriate primary language “EN-GB” defined. 
[image: PDF with correctly defined primary language.]
Ensure that incorrect primary language is not defined for the file.
For example, in the 2020-Roles-and-responsibilities-of-the-chair.pdf, the file has an incorrect primary language “French” defined. 
[image: PDF with incorrect primary language defined. ]
Ensure that primary language is defined for every file. 
For example, in the 2020-Chief-Executives-strategic-overview.pdf, primary language is missing for the file. 


[image: Primary language not defined for the PDF file. ]
How to test for Accessibility?
To check a file’s primary language, perform the following steps:
1. Open the PDF file that needs to be tested using Acrobat Professional.
2. Click on File > Document Properties > Advance Tab > Reading Option > Language.
3. Check if primary language is defined accurately.
4. If the condition in step 3 fails than it is an accessibility violation as per WCAG 2.1 success criteria 3.1.1 at Level A.

[bookmark: _Toc57986880]Secondary Language
If the PDF document’s primary language is English and there is a paragraph in Spanish on a page, both the primary and secondary language need to be defined. If a language change is not defined, a screen reader might continue to read the Spanish paragraph in English. This will result in misinterpretation of information, so it is essential to define the document’s primary and secondary languages (if any) to ensure that content is rendered accurately. 

[image: ]

	WCAG Success Criteria
	WCAG Conformance Level

	3.1.2 Language of Parts
	AA


How to implement?
This section lists the techniques for defining the secondary language of a PDF document.
· Define the secondary language from the respective tag’s properties from the Content or Tags Tab.
· Authors can either select the language from the drop-down or type in the language code.
Tip: 
If screen reader does not identify change in language define the language in both Content and Tags tab of the Properties dialog.

Practices to Apply & Avoid
 Define the secondary language accurately.

For example, in the Chez Nous_5e_IPA3_CHs5-7_SE_FINAL.pdf, secondary language “French” is defined for the content- “ALLO RESTO est Clairmont le pionnier ….”in both the “Content” and “Tag” tab.


[image: Secondary language French defined accurately in "Content" tab.]

[image: Secondary language French defined accurately in "Tag" tab.]

Avoid defining secondary language inaccurately.
For example, in the Chez Nous_5e_IPA3_CHs5-7_SE_FINAL.pdf, secondary language “English US” is defined incorrectly for the content- “1. Selon la narratrice, la discipline du yoga… “in both the “Content” and “Tag” tabs.
[image: Secondary language French defined inaccurately in "Content" tab.]
[image: Secondary language French defined inaccurately "Tag" tab.]
Ensure that secondary language is defined for every page. 
For example, in the Chez Nous_5e_IPA3_CHs5-7_SE_FINAL.pdf, secondary language of both “Content” and “Tag” tabs for the content “Deliveroo vous fait la promesse d’être livré en moins de 30…..” is missing. 

[image: Secondary language is missing in “Content” tab.]

[image: Secondary language is missing in “Tag” tab. ]
How to test for Accessibility?
To check if secondary language is defined correctly, perform the following steps:
1. Open the PDF file that needs to be tested using Acrobat Professional.
2. Select the text in secondary language and open the Tags Panel.
3. Click on “Find Tag from Selection” available below Options in the Tags Panel.
4. Right-click on the Tag and click on Properties.
5. Check if secondary language is specified in the Contents and Tags tab.
6. If the condition in step 5 fails than it is an accessibility violation as per WCAG 2.1 success criteria 3.1.2 at Level AA.

[bookmark: _Toc57986881]Abbreviations and Acronyms
Abbreviations are shortened form of words, name, or phrase, such as W3C, WCAG etc. Acronyms on the other hand are abbreviated forms made from initial letters or other parts of a word, name or phrase which may be pronounced as a word, such as WHO, USA etc.
Expanded form of abbreviations and acronyms need to be provided to ensure their meaning is clear for all users correctly. Assistive technologies such as screen readers support reading of abbreviations and acronyms if they are tagged correctly. However, by default screen readers are not configured to read expansion of abbreviated words but provide users with options to do so through screen reader settings.
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	3.1.4 Abbreviations
	AAA


How to implement?
This section lists the techniques that need to be implemented in order to tag abbreviations or acronyms in a PDF document.
· Add the full form of abbreviations and acronyms by typing it in the Expansion Text field available in the Contents Tab of the tag’s properties.

Tip: 
Add expansion for abbreviations and acronyms only for the first occurrence in the document to avoid excessive listening for screen reader users.

Practices to Apply & Avoid
Avoid using abbreviations without specifying their expansion in a file. 
For example, in the 2020-LTIP-target-disclosure-FINAL.pdf, the expansion for the term “FTSE” is not specified in the expansion text box at the first occurrence. 
[image: Expansion text for the term "FTSE" not specified. ]
Provide the full form of an abbreviation.

For example, in the 2020-LTIP-target-disclosure-FINAL.pdf, the expansion for the term “FTSE” is specified as “Financial Times Stock Exchange (FTSE)” in the expansion text box at the first occurrence.
[image: Expansion text for the term "FTSE" specified as "Financial Times Stock Exchange (FTSE)".]

User Groups Affected
· Blind users
· Low-vision users
· Deaf-blind users

How to test for Accessibility?
To check if expansion for abbreviations and acronyms are specified in the first occurrence in the PDF document, perform the following steps:
1. Open the PDF file that needs to be tested using the Acrobat Professional.
2. Select the abbreviation or acronym text and open the Tags Panel.
3. Click on “Find Tag from Selection” available below Options in the Tags Panel.
4. Right-click on the tag’s properties and click on the Contents Tab.
5. Check if full form of abbreviation or acronym is specified in the Expansion Text box.
6. If the condition in step 5 fails than it is an accessibility violation as per WCAG 2.1 success criteria 3.1.4 at Level AAA.




[bookmark: _Toc57986882]STEM EQUATIONS
Science Technology Engineering Mathematics (STEM) content is one of the most challenging types of content as far as accessibility is concerned. At the same time, it is crucial to make it accessible to ensure learners with different types of disabilities can access the content using their Assistive Technology. 
STEM education is important as it teaches logic and critical thinking. STEM education is also important as it is required in different job profiles on offer in the market. However, learners with disabilities are often at a disadvantage since STEM content is not created keeping accessibility in mind. STEM content consists of equations, subscripts, and superscripts as well as mathematic formulas to a large extent. It also includes simulations, experiments, and diagrams. 
[image: ]
4.1.2 Name, Role, Value								Level A
For all user interface components (including but not limited to: form elements, links and components generated by script), the name and role can be programmatically determined; states, properties, and values that can be set by the user can be programmatically set; and notification of changes to these items is available to user agents, including assistive technologies. 

[bookmark: _Toc57986883]Alternate text for formula tags
Formula tags are used to present accessible math content in a PDF document. Alternate text needs to be specified for mathematical equations to enable users with visual disabilities to access the math content. Adding descriptions via the alternate text does not provide an equitable experience for users with visual disabilities while accessing math content but currently it is the only option available to make the math content accessible for them. 
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	4.1.2 Name, Role, Value
	Level A


How to implement?
This section lists the techniques for implementing accessible math content in a PDF document.
· Use the <Formula> tag to tag the math content. 
· Add description for the math content via the actual text field of the <Formula> tag. 
Tip: 
Spell the mathematical symbols, such as “fraction” instead of using symbols within the actual text to make it easier for screen reader users to interpret the content. 
Note: As per the accessibility guidance documented in different PDF accessibility standards and guidelines, alternate alternative text needs to be specified for the <Formula> tag. However, at Pearson we require textual description for the math equation using the actual text property of the <Formula> tag. Using the actual text property allows all screen readers to announce the alternative text for <formula> tag elements.

Practices to Apply & Avoid
Specify alternate text in the actual text field for all math equations within a PDF document.

For example, in the Berk_sg03.pdf, the actual text for the equation highlighted in the screenshot is specified as “Present value of retiring in one year equals to $3,000,000 plus $100,000 divided by 1.05 equals to $2,952,381”.
	Comment by AnnMarie Short: We will need to change this example. Let me know if you need an example with actual text. I have some.
[image: Actual text specified for the math equation. ]
Avoid using <Formula> tags that lack textual descriptions.
For example, in the Berk_sg03.pdf, the actual text for the equation is not specified.
[image: Alternate text not specified for math equation.]	Comment by AnnMarie Short: Change example
Make use of the <Formula> tag.
For example, in the Berk_sg03.pdf, the formula ($10,000) / (1+r) is incorrectly tagged using the <P> tag. 
[image: Math content displayed using <P> tag.]
User Groups Affected
· Blind users
· Low-vision users
· Deaf-blind users
How to test for Accessibility?
To test math content in a PDF document, perform the following steps:
1. Open the PDF document that needs to be tested in Acrobat Professional.
2. Open the Tags Panel.
3. Select the math content and click on “Find tag from selection” available below the “Options” control.
4. Check if accurate textual description is specified via the actual text field of the <Formula> tag.
5. If the condition in step 4 fails, then it is an accessibility violation as per WCAG 2.1 success criteria 4.1.2 at Level A.
 


[bookmark: _Toc57986884]READING AND TAGGING ORDER
A document’s structure helps assistive technologies, such as screen readers, to render the content in a manner that can be interpreted by the users. For example, on the basis of the structure, a screen reader will identify headings of a document, determine the type of list, as well as read out the table headers while rendering tabular information for their users. 
Screen reader users rely on this information, as it not only helps them to navigate within the document but also helps in interpreting the content easily. Structure helps them to understand the relationship between two pieces of information. i.e., a section heading and the paragraph of text.  
In a PDF file, document structure determines the order in which content is rendered by assistive technology, as well as defines the tabbing order for the document. On the basis of the document structure, keyboard-only users can navigate between the interactive elements, such as links and form controls, in a meaningful sequence. Thus, it is essential that a PDF document’s structure is set appropriately to ensure that assistive technologies can render the information in a meaningful sequence for their users. 

[image: ]
1.3.2 Meaningful Sequence								Level A
When the sequence in which content is presented affects its meaning, a correct reading sequence can be programmatically determined.

[bookmark: _Toc57986885]Tag order
Tag order is the order in which assistive technologies, such as screen reader reads the document’s content for their users. Tagging order needs to be therefore set in a manner that it can render the content in a meaningful sequence for screen reader users. 
When a document is looked at visually, content can make perfect sense but when the same content is rendered with a screen reader running it makes it difficult for users to interpret the content. For example, a PDF document includes information in a columnar format. The document is tagged in such a way that after first paragraph of column 1, first paragraph of column 2 is tagged. Even though the content will yet make perfect sense visually it will break the reading sequence for screen reader users. All the content of column 1 needs to be tagged first followed by all the content of column 2 to make it meaningful for screen reader users. 


[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.2 Meaningful Sequence
	A


How to implement?
This section lists the techniques for implementing accurate tagging order in a PDF document.
· Tag all the content in a meaningful sequence.
· Tag supplementary content such as sidebars at the end or beginning of the content of the page even though it might be available at the middle of the page. 
Practices to Apply & Avoid
Ensure the content’s tag order is accurate.

For example, in the 2019-ar.pdf, the tagging order is the same as the visual order. 
Content of the document is tagged in the following order:
1. <H1> “Pearson is Transforming to Succeed”
2. <p> “Sidney Taurel Chair”
3. <Figure> Image of Sidney Taurel
4. <P> “Dear shareholders”
5. <p> “In a year of significant change….”
6. <H2> “Progress and performance”
7. <P> “We entered 2019 with a determination….”

[image: Page with correct tagging order. ]
Avoid tagging the content in an incorrect order.
For example, in the 2019-ar.pdf, the tagging order of the page is incorrect. It does not match with the visual order.
Content of the document is tagged in the following order:
1. <P> “2020 Remuneration policy”
2. <P> “The remuneration Committee….”
3. <P> “In 2019, Pearson reviewed”
4. <P> “1”
5. <P> “Aligned to no longer…..”
6. <P> “4”
7. <P> “Targeted differentiation”
8. <P> “3”
9. <P> “Market competitive”
10. <P> “3”
11. <P> “Pay for performance”
[image: Page with incorrect tagging order. ]


How to test for Accessibility?
To test the tag order of a PDF document, perform the following steps:
1. Open the PDF document that needs to be tested in Acrobat Reader.
2. Turn on JAWS or NVDA.
3. Press the Down Arrow to access the document’s content.
4. Listen if the content is read out in a meaningful sequence.
5. If the condition in step 4 fails than it is an accessibility violation as per WCAG 2.1 success criteria 1.3.2 at Level A.
[bookmark: _Toc57986886]Content Order
Content order is the order which is used by Adobe for displaying content in Reflow mode. Content order is also used for displaying PDF documents on a mobile device. Content order might be accurate, and one would assume that the content of the document will be available in a meaningful sequence for screen reader users. However, tagging order is the order which screen reader relies on for rendering the document’s content for their users. 
Tip: 
Ensure that content and tag order of the document is identical to make the document accessible for a wide range of users with impairments.

How to implement?
This section lists the techniques for implementing accurate content order in a PDF document.
· Check if the content is available in the meaningful sequence in the Order Panel and if any change is required then;
· Rearrange the content boxes in the Content Panel (available above Reading Order Tool) to make the information available in a meaningful sequence in different display modes.

Practices to Apply & Avoid
Ensure the content order is the same as the reading order. 

For example, in the 2020-LTIP-target-disclosure-FINAL.pdf, the content order matches with the reading order. 
Sequence of the content order is:
1. <H1> “Long Term Incentive Plan”
2. <H2> “Performance targets for the 2020 awards to….”
3. <P> “At the time the annual…”
4. <P> “The award will vest…”
5. <LBody> “1/3 of the award….”
6. <LBody> “1/3 of the award….”
7. <LBody> “1/3 of the award….”
8. <P> “Details of the performance…”
[image: Page with correct content order. ]
Avoid tagging content in an order that fails to result in screen readers reading the information in an illogical order.
For example, in the 2020-Roles-and-responsibilities-of-the-chair.pdf, the content order does not match with the reading order. 
Sequence of the content order is:
1. Footer: “Approved by the board…”
2. Image of Pearson’s logo
3. <P> “Role of chair”
4. <P> “ A. The chair is responsible….”
5. <LBody> “1. Meetings”
6. <LBody> “Chairing boards and general meetings…..”

[image: Page with incorrect content order. ]

User Groups Affected
· Blind users
· Low-vision users
· Users with learning disabilities. 


How to test for Accessibility?
To test the content order of a PDF document, perform the following steps:
1. Open the PDF file that needs to be tested using Acrobat Professional.
2. Open Order Panel available in the Navigation Pane.
3. Content of the page will be displayed in boxes with each box having a number besides it.
4. Check if the content boxes match with the visual order.
5. Check if the content boxes are available in a meaningful sequence.
6. If conditions in step 4 and 5 fail, then it is an accessibility violation as per WCAG 2.1 success criteria 1.3.2 at Level A.
Tip:
Content displayed in the order Panel is also referred to as the Z order.
[bookmark: _Toc57986887]LINKS
Links are used in a PDF document to help users navigate from one document section to another, and even to external websites. Screen readers identify a link based on the link’s text. Keyboard-only users can navigate from one link to another by pressing the “Tab” key, and they can activate a link by pressing the “Enter” key. Screen reader users can also navigate and activate links just like keyboard-only users. A screen reader also provides an option to access all the document’s links in the form of a list. 

Tip: 
Press “Insert + F7” to pull up Links List and Elements List dialog in JAWS and NVDA respectively.

[image: ]
1.3.1 Info and Relationships								Level A
Information, structure, and relationships conveyed through presentation can be programmatically determined or are available in text.
2.1.1 Keyboard									Level A
All functionality of the content is operable through a keyboard interface without requiring specific timings for individual keystrokes, except where the underlying function requires input that depends on the path of the user’s movement and not just the endpoints. 
2.4.4 Link Purpose (In Context)							Level A
The purpose of each link can be determined from the link text alone or from the link text together with its programmatically determined link context, except where the purpose of the link would be ambiguous to users in general.

[bookmark: _Toc57986888]OBJR
Links in a PDF document need to be defined programmatically to ensure that they are recognized by assistive technologies, such as screen readers and can be activated using a keyboard. A Link tag consists of two parts, text of the link which is visible for all users and the Link-OBJR tag which points to the destination target of the link. 
PDF links can be links to external websites or documents as well as page or section within the document itself. They are referred to as web links and internal links, respectively. The structure of the Link tag remains the same irrespective of the type of link. A link should not only look like a link but also function as a link with different input devices as well. This can be achieved with the Link-OBJR tag. The Link-OBJR tag plays a very essential part for making links accessible for different user groups. 
Tip: 
Press “Tab” and “Shift + Tab” key to navigate to the next and previous link using a keyboard. To activate a link, press “Enter”.
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	2.1.1 Keyboard
	A

	1.3.1 Info and Relationships
	A


How to implement?
This section lists the techniques for implementing links with a valid Link-OBJR tag in the PDF document.
· Tag the link text using the <Link> tag.
· Add the destination target of the link via the Link-OBJR tag.
· Ensure that the link points to a valid target.
· Set the destination target (applicable when the internal link is meant to target a particular section or sub-section of the PDF document) for an internal link available through “Create link” option. 
· Scroll to the correct page in the PDF document for internal link that is meant to target a particular page.

Practices to Apply & Avoid
Ensure that links are tagged with appropriate Link-OBJR tag. The <Link> tag should be used to include the link text. The Link-OBJR tag is used to include the destination target.

For example, in the Pearson-Indicative-allocation-and-impact-reporting-template-Final-v3.pdf, the web link of “https://stats.oecd.org/glossary/detail.asp?ID=6326” has been appropriately tagged using the Link-OBJR tag.

[image: Link-OBJR tag used to define a weblink.]
Avoid tagging links without the Link-OBJR tag.
For example, in the M05_NURS6803_03_SE_C05_MM.pdf, the internal link of “Figure 2” is tagged without using the Link-OBJR tag.

[image: Link tagged without the Link-OBJR tag.]

Avoid defining a web link without tagging it using a <Link> tag.
For example, in the Pearson-Indicative-allocation-and-impact-reporting-template-Final-v3.pdf, the web link is tagged incorrectly using the <Span> tag. 

[image: Web link tagged inappropriately using the <Span> tag]

Ensure to tag web links using the <Link> tag.

For example, in the 2020-Governance.pdf, the web link of “www.pearson.com/governance” is tagged correctly using the <Link> tag. 
[image: Web link tagged appropriately using the<Link-OBJR> tag.]

Ensure to use Link-OBJR tag in web links to make them accessible for assistive technology users. 

Ensure that internal links are created using <Link> and Link-OBJR tags. 

For example, in the M05_NURS6803_03_SE_C05_MM.pdf, the internal link of “see Figure 4” is tagged correctly using the <Link> and Link-OBJR tags.
[image: Internal link tagged correctly using <Link> and <Link-OBJR> tags.]

Avoid defining an internal link without tagging it as a link programmatically.
For example, in the 2019-ar.pdf file, the internal link of “Read more on employee engagement on p62” is tagged incorrectly without using the <Link> and Link-OBJR tags.
[image: Internal link tagged incorrectly without using <Link> and <Link-OBJR> tags]
User Groups Affected
Blind users
Low-vision users
Users with learning disabilities.
Users with mobility disabilities.


How to test for Accessibility?
To check if links have valid Link-OBJR, perform the following steps:
1. Open the PDF file that needs to be tested using Acrobat Professional.
2. Select the <Link> tag in the Tags Panel.
3. Click on “Option” in the Tags Panel.
4. Click on “Find” and select “Unmarked links” from the drop-down.
5. Click on “Find”.
6. If unmarked links are found after performing step 2 – step 5, then it is an accessibility violation as per WCAG 2.1 success criteria 1.3.1 and 2.1.1 at Level A.

[bookmark: _Toc57986889]Descriptive Link Text
PDF links are often site URLs that fail to clearly describe their destination target for screen reader users. Screen reader users access links often in the form of a list where only the text of the link is available and not the surrounding text. This is referred to as “links out of context”. Thus, it is very important to specify descriptive text for each link in a PDF document. 
Acrobat Professional provides authors with an option to add descriptive link text via the alternate text field of the <Link> tag. This will result in descriptive text being read out to screen reader users whereas the link’s text remains unchanged in the document. 
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	2.4.4 Link Purpose (In Context)
	A



How to implement?
This section lists the techniques for adding descriptive text for links in a PDF document.
· Add descriptive text for links via the alternate text field. The alternate text field option is available from the <Link> tag’s Properties dialog. 
· Use the web page’s title as the description in the case of URL links.
Practices to Apply & Avoid
Specify descriptive alternate text for links.

For example, in the Pearson-Indicative-allocation-and-impact-reporting-template-Final-v3.pdf, alternate text for the web link “https://stats.oecd.org/glossary/detail.asp?ID=6326” describes the location of the link, i.e. “Link to Glossary to Statistical terms”.
[image: Web link with an accurate and descriptive alternate text. ]

User Groups Affected
Blind users
Low-vision users

How to test for Accessibility?
To check if link text is descriptive, perform the following steps:
1. Open the PDF file that needs to be tested using Adobe Reader.
2. Turn on JAWS or NVDA.
3. Navigate to different links of the file using any of the following keystrokes:
a. Press “Tab” or “Shift + Tab” to navigate to next and previous link respectively.
b. Press “Insert + F7” to activate the list of links of the entire file.
4. Listen if each link’s text is descriptive of their target.
5. If the condition in step 4 fails, then it is an accessibility violation as per WCAG 2.1 success criteria 2.4.1 at Level A.

[bookmark: _Toc57986890]TOC Links
Table of Content (TOC) links are used generally at the start of the document to allow users jump to the different pages or sections in the file. TOC links are similar to other links in the PDF document except for couple of tag structural changes. In the case of TOC links, name of the section and page numbers are tagged using <TOCI> and <Reference> tags along with the standard <Link> and Link-OBJR tags.
TOC links are internal links that point to a particular page and even section in certain cases. TOC links help users to quickly access different sections of the document. Table of Contents depict the content outline of the document and links help users find the required content quickly rather than reading through the entire document. 

[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.1 Info and Relationships
	A

	2.1.1 Keyboard
	A


How to implement?
This section lists the techniques that need to be implemented for tagging TOC links in a PDF document.
Define TOC links using accurate tag structure:
· <TOC>: parent container to the table of content items.
· <TOCI> used to tag individual table of content items.
· <Reference> used in the case of linked table of contents.
· <Link> used to add text and page number of individual tables of content item.
· Link-OBJR to define the link’s destination.
Tag the leaders “… … ” as artifact to make sure that screen reader skips it.
Set the destination correctly for each link if it points to a page or if it points to a section within a page. 


Note: In JAWS and NVDA on activating the TOC links, focus fails to move to accurate destination despite of setting it up correctly through the Tags Panel. 

Practices to Apply & Avoid
Ensure that TOC content is linked correctly. 

For example, in the 2019-ar.pdf file, the TOC content is tagged correctly using the <Link> tag.

[image: TOC links marked accurately using <link> tag.]
Avoid defining a TOC link without tagging it as a link programmatically.
For example, in the 2019-ar.pdf file, the TOC content is tagged inaccurately without using the <Link> tag. 
[image: TOC links tagged inaccurately.]

User Groups Affected
· Blind users
· Low-vision users
· Users with learning disabilities.
· Users with mobility disabilities.

How to test for Accessibility?
To test TOC links in an accessible PDF document, perform the following steps:
1. Open the PDF document that needs to be tested using Acrobat Professional.
2. Navigate to the Table of Contents and select it.
3. Open the Tags Panel and select “Find Tag from Selection” available below Options.
4. Check if the TOC links are defined using correct tag structure, such as <TOC>, <TOCI>, <Reference>, <Link> and Link-OBJR tags.
5. Check if the TOC links point to the correct destination.
6. If the conditions in step 4 and 5 fail than it is an accessibility violation as per WCAG 2.1 success criteria 1.3.1 and 2.1.1 at Level A.



[bookmark: _Toc57986891]FOOTNOTES AND ENDNOTES
Footnotes and endnotes are used to provide reference for the cited information used within the document. A footnote is displayed at the end of a page whereas an endknot is displayed at the end of the document. A footnote is indicated either with a symbol or numbers. These symbols or numbers are presented as superscript character within the page and the same symbol is used towards the end of the page along with the cited information. 
Endnotes are displayed at the end of the document and they contain cited information as well as reference links. Footnotes and endnotes are either provided as static text or linked text characters. Following tags are used to tag footnotes and endnotes:
<Reference> 
<Note>
<Label> 
<Link>
Link-OBJR
<P>, <Span> etc.
[bookmark: _Toc57986892]Reference Tag
OBJR <Reference> tag is used to include the citation in the page. To make the information meaningful for screen reader users, actual text “Note 1” is added via the <Reference> tag’s properties. This text is read out by the screen reader when users access the document with Arrow keys.
In the case of linked footnotes or endnotes, the <Link> and Link-OBJR tags are included just after the <Reference> tag. Descriptive text is added via the alternate text field of the <Link> tag in the case of linked footnotes or endnotes. Additionally, actual text is not added for the <Reference> tag.
Footnotes or endnotes do not work as intended for keyboard-only and screen reader users in a PDF document. Keyboard-only users can activate the link and navigate to the information at the end of the page or document, but they cannot navigate back to their original location. This results in users having to find their way back to their original location in the file.
Screen reader users can neither navigate to the associated information at the end of the page or document nor they can move back. In fact, when screen reader users activate linked footnote or endnote, their focus remains on the link itself. To make the footnote or endnote information available for screen reader users one of the following approaches can be adopted:
Move the footnote or endnote text immediately after the <Reference> and <Note> tags.
If implementing the first approach breaks the reading sequence for screen reader users, then move the footnote or endnote information after the paragraph, table, list or heading besides which it is displayed. Alternatively, add the information at the end of a section or sub-section of the document.
Note: There is no perfect answer about where the footnote or endnote text be moved for the benefit of screen reader users. Thus, it is recommended to move it where it does not disturb the reading flow for users.
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.1 Info and Relationships
	A

	2.1.1 Keyboard
	A


How to implement?
This section lists the techniques for using the <Reference> tag for displaying footnotes and endnotes in an accessible PDF document.
Use the <Reference> tag to include the <Note> and <Label> tags.
Add actual text using the Actual Text option available within the <Reference> tag’s Properties.
Use the <Link> and Link-OBJR tags to include the descriptive text and link the footnote/endnote to their respective destination. 
Add descriptive text (e.g. “Note 1”) via the alternate text field of the <Link> tag.

Practices to Apply & Avoid
Use <Reference> tag for tagging the footnote/endnote reference.

For example, in the 2019-ar.pdf, the <Reference> tag is used appropriately to tag references of footnotes.
[image: Footnote marked correctly using the <Reference> tag.]
Avoid tagging the footnote/endnote without using the <Reference> tag. 
For example, in the 2019-ar.pdf, the reference is tagged inappropriately using the <Span> tag. 
[image: Reference marked incorrectly using the <Span> tag.]
Ensure that actual text is specified for <Reference> tag.

For example, in the 2019-ar.pdf, actual text of “Note 4 “is provided for the <Reference> tag.

[image: Actual Text “Note 4” specified for the <Reference> tag.]
Avoid using <Reference> tag with no actual text.
For example, in the 2019-ar.pdf, actual text is missing for the <Reference> tag.

[image: Actual text not specified for the <Reference> tag.]

Use <Link> and Link-OBJR tags for tagging references of linked footnotes/endnotes.

For example, in the 2019-ar.pdf, <Link> and Link-OBJR tags are correctly used to tag the reference for linked footnotes/endnotes.

[image: <Link> and Link-OBJR tags used correctly to mark reference.]

User Groups Affected
Blind users
Low-vision users
Deaf-blind users
Keyboard-only users

How to test for Accessibility?
To test the <Reference> tag, perform the following steps:
1. Open the PDF file that needs to be tested using Acrobat Professional.
2. Select the footnote/endnote and open the Tags Panel.
3. Click on “Find Tag from Selection” available below “Options” in the Tags Panel.
4. Check if <Reference> <Link> and Link-OBJR tags are used in the case of static and linked footnotes/endnotes correctly.
5. If the condition in step 4 fails, then it is an accessibility violation as per WCAG 2.1 success criteria 1.3.1 and 2.1.1 at Level A.
[bookmark: _Toc57986893]Note Tag
<Note> tag contains the <Label> tag and includes the footnote/endnote text. A unique id needs to be specified for the <Note> tag. The <Label> tag is optional and is used to tag the footnote/endnote character within the page. The footnote/endnote text available at the end of the page or document is recommended to be placed immediately after the <Note> tag.
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.2 Meaningful Sequence
	A


How to implement?
This section lists the techniques to implement the <Note> tag for tagging footnote/endnote in an accessible PDF document.
Use the <Note> tag that contains the <Label> tag.
Specify a unique id to the <Note> tag.
Use the <Label> tag to include the footnote/endnote character.
Specify actual text for the <Label> tag (e.g. Note 1).
Move the footnote/endnote text immediately after the <Label> tag. 

Practices to Apply & Avoid
Use the <Note> tag that contains the <Label> tag. 

For example, in the 2019-ar.pdf, the <Note> tag is used appropriately to display footnotes. 
[image: <Note> tag used correctly.]
Avoid using <Footnotes> tag for references. 
For example, in the 2019-ar.pdf, the <Footnotes> tag is used to tag footnotes for references. 

[image: Inappropriate use of <footnote> tag to tag references. ]

User Groups Affected
· Blind users
· Low-vision users
· Deaf-blind users

How to test for Accessibility?
To test correct implementation of the <Note> tag, perform the following steps:
1. Open the PDF document that needs to be tested using Acrobat Professional.
2. Select the footnote/endnote character and open the Tags Panel.
3. Click on “Find Tag from Selection” and available below Options in the Tags Panel.
4. Check if the <Note> and <Label> tags are used correctly. Also check if unique id is specified for the <Note> tag and actual text is specified for the <Label> tag, respectively.
5. Check if the footnote/endnote text is moved in a correct location for the benefit of screen reader users.
6. If the conditions in step 4 and 5 fail than it is an accessibility violation as per WCAG 2.1 success criteria 1.3.2 at Level A.





[bookmark: _Toc57986894]BOOKMARKS
Bookmarks provide a hierarchical outline of the document which allows users to traverse through the entries and access the required content quickly. Bookmarks provide users with a quick means to navigate through a long document instead of going through all the pages. Bookmarks are found very useful by people with visual and learning disabilities. 
[image: ]
2.4.5 Multiple Ways									Level AA
More than one way is available to locate a Web page within a set of Web pages except where the Web Page is the result of, or a step in, a process. 

[bookmark: _Toc57986895]Define bookmarks based on headings
Bookmarks can be defined using different structural elements, such as headings, paragraphs, tables, links, pages, views etc. Bookmarks should be defined after defining tags in a document. Bookmarks defined on document headings provide users with an option to navigate to different sections as well as sub-sections in the document quickly. 
Tip: 
Define bookmarks only after tagging the document headings. 
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	2.4.5 Multiple Ways
	Level AA


How to implement?
This section lists the techniques for defining bookmarks in a PDF document:
· Define headings for all sections and sub-sections in a document.
· Add bookmarks from the Navigation pane > Options > New bookmarks from structure > Document headings.
· Nest bookmarks based on document’s content structure.

Note: By default, new bookmarks are added at a single level and must be nested based on the section and sub-section headings available in the document. 

Practices to Apply & Avoid
Avoid skipping heading levels while defining bookmarks 
For example, in the 2019-ar.pdf, Bookmarks for Heading Levels <H3>, <H4> and <H5> are missing.
[image: Missing bookmark for heading level <H3>, <H4> and <H5>.]
Ensure to add bookmarks for all heading levels. If this is not feasible, define bookmarks for heading level 3 (<H3>) at the minimum. 

For example, in the 2019-ar.pdf, bookmarks have been added for all heading levels. 
[image: Bookmarks defined for all heading levels.]

User Groups Affected
· Users with visual disabilities 
· Users with learning disabilities 

How to test for Accessibility?
To test a PDF document’s bookmarks, perform the following steps:
1. Open the PDF document that needs to be tested.
2. Open Navigations Pane and click on Bookmarks.
3. Check if bookmarks are defined and nested accurately based on the document’s structure.
4. Check if all bookmarks have a meaningful title and there is no “untitled” bookmark present.
5. If conditions in step 3 and 4 fail than it is an accessibility violation as per WCAG success criteria 2.4.5 at Level AA.



[bookmark: _Toc57986896]FORMS
PDF forms are used to collect information from users. Each PDF document uploaded on a website that includes form fields should be made accessible to ensure users with different types of disabilities can fill out the form successfully and independently. 
PDF forms should be created using appropriate form tags and each form field must have a unique label. Form instructions should be made available to users up front, and error messages should also be identified. 
When screen reader users interact with form fields, they need to know a field’s label in order to fill in the details, form instructions should be available up front to help them while filling in the details and error messages should be clear to help them submit the form successfully. 
When form fields are not made accessible, screen reader users will find it difficult to access the form fields and complete the form successfully. In addition to the above, a logical tabbing order should be defined for the form fields to help keyboard-only and screen reader users navigate between form fields easily. 
[image: ]
1.3.1 Info and Relationships								Level A
Information, structure, and relationships conveyed through presentation can be programmatically determined or are available in text.
2.4.3 Focus Order									Level A
If a webpage can be navigated sequentially and the navigation sequences affect meaning or operation, focusable components receive focus in an order that preserves meaning and operability.
2.5.3 Label in Name									Level A
For user interface components with labels that include text or images of text, the name contains the text that is presented visually. 
3.3.1 Error Identification								Level A
In an input is automatically detected, the item that is in the error is identified and the error is describe to the user in text. 
3.3.2 Labels or instruction								Level A
Labels or instructions are provided when content requires user input.
4.1.2 Name, Role, Value								Level A
For all user interface components (including but not limited to: form elements, links and components generated by script), the name and role can be programmatically determined; states, properties, and values that can be set by the user can be programmatically set; and notification of changes to these items is available to user agents, including assistive technologies. 
2.4.6 Headings and Labels								Level AA
Headings and labels describe topic or purpose.
3.3.3 Error Suggestion								Level AA
If an input error is automatically detected and suggestions are known, then the suggestions are provided to the user, unless it would jeopardize, the security or the purpose of the content.
3.3.4 Error Prevention								Level AA
For web pages that cause legal commitments or financial transactions for the user to occur, that modify or delete user-controllable data in data storage systems, or that submit user test responses, at least one of the following is true:
1. Reversible: Submissions are reversible.
2. Checked: Data entered by the user is checked for input errors and the user is provided an opportunity to correct them.
3. Confirmed: A mechanism is available for reviewing, confirming and correcting information before finalizing the submission.  

Acrobat Professional DC is one of the recommended application that may be used for fixing existing PDF forms or authoring new forms. Using Acrobat Professional, different type of form fields can be added or edited, such as input fields, checkboxes, radio buttons, buttons etc. 
To create accessible PDF forms using Adobe Acrobat Professional DC perform the following steps:
1. On the “Tools” tab, select the “Prepare Form” option.
 
[image: "Prepare Form" highlighted in the "Tools" tab.]
 
2. Select the “Start” button to start tagging the form.  
 
[image: "Start" button highlighted to start tagging the form file. ]
3. Fields will get added to the document automatically.  
4. Right-click on the field and select “Properties” option. 
5. Edit “Name and Tooltip” fields from the “Properties” dialog. “Name” acts as a unique id for a field whereas “Tooltip” is used to assign label for a form field.   
 
[image: "Name" and "Tooltip" properties of a text field highlighted in the "Text Field" properties box. ]
 
6. Right-click and select “New Tag” option. This needs to be done to tag each textual label using separate <P> tag.  
7. Select “Type: Paragraph”. 

[image: "Paragraph" option selected in the "New Tag" box.]
 
8. Right-click on the <P> tag created and select “New Tag” option.  
9. Select “Type: Form”. 

[image: "Paragraph" option selected in the "New Tag" box.]
 
10. Select the text and the Form tag.  
11. Right-click on the form tag and then select “Create Tag from Selection” option. 
12. Right-click on the text and Select “Find” option. 
[image: "Find" option highlighted after right clicking on the form tag. ]

 
13. Find for “Unmarked Annotations” from find element dialog box. 

[image: "Unmarked Annotations" highlighted in the "Find Element" box. ]
 
14. Click on “Find or Find Next” button.  
15. Select desired element and Click on the “Tag Element” button. 

[image: "Tag Element" highlighted in the "Find Element" box. ]
 
Note: Remove the unnecessary fields that get automatically added to the form. 

[bookmark: _Toc57986897]Form field properties
Form field properties help to customize PDF form fields. Authors can customize field’s alignment, size, combing, styles, numbers etc. These customizations help to set up basic form validations such as maximum characters allowed, number format, password, time, date and even custom. Authors can customize the form field properties using Format Tab and Options Tab of the Properties dialog box.
Note: Properties dialog box shows different options in the Options Tab for different types of form fields. 
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	3.3.1 Error Identification
	A

	3.3.2 Labels or Instructions
	A


How to implement?
This section lists the techniques for applying different form field properties in an accessible PDF form.
· Set the properties using the Format and Options Tab of the Properties dialog box. To access the Properties dialog box for a form field either double-click on the field or right-click on the field and select Properties option from the context menu.

Adobe offers detailed guidance on how to set up each type of form fields and they can be found at: https://helpx.adobe.com/in/acrobat/using/pdf-form-field-properties.html#options_tab_for_form_field_properties
Some of the key options available for form fields in the Format and Options Tab are listed in the following tables: 

	Format Tab Form Field Property
	Description

	None
	No additional options are available. The input in a text or dropdown box with this property does not require any specific formatting.

	Number
	Imposes the selected formatting options on numeric data entries of decimal places, separator style, currency symbol, Symbol location and negative number style.

	Percentage
	Imposes the selected formatting options on numeric data expressed as a percentage.

	Date
	List includes one-, two-, and four-digit variations where d stands for the day, m stands for month, and y stands for year.

	Time
	List includes display variations where h stands for the hour on a 12-hour clock, H stands for the hour on a 24-hour clock, MM stands for minutes, ss stands for the seconds, and tt stands for AM or PM.

	Special
	Includes zip code, zip code +4, phone number, Social Security Number, Arbitrary Mask

	Custom
	[bookmark: _Hlk57305118]Makes additional options available to form designers who want to write their own JavaScripts for formatting and keystrokes.





	Option Tab Form Field Property
	Description

	Scroll Long Text
	Compensates for text that extends beyond the boundaries of the text field.

	Multi-line
	Allows more than a single-line entry in the text field.

	Default Value
	Specifies the text that appears until the user overwrites it by typing in the field. Enter the default value by typing in this option.

	Alignment
	Aligns the text left, right, or center within the field.

	Limit Of Characters
	Allows entries of up to the number of characters you specify.

	Password
	Displays the user-entered text as a series of asterisks (*). This option is available only if Check Spelling is deselected.

	Field Is Used For File Selection

	Allows the user to enter a file path as the field’s value when a file is submitted along with the form. This option is available only when Scroll Long Text is the only selected option in the Options tab.

	Check Spelling
	Checks the spelling of user-entered text.

	Allow Rich Text Formatting
	Allows users to apply styling information to the text, such as bold or italic. This might be useful in certain text fields where such styling information is important to the meaning of the text, such as an essay.

	Comb Of Characters

	Spreads the user-entered text evenly across the width of the text field. If a border color is specified in the Appearance tab, each character entered in the field is separated by lines of that color. This option is available only when no other check box is selected.





Practices to Apply & Avoid
Avoid using untagged or unidentified form fields.

For example, in the M07_LIAL2130_13_MyNotes_C07.pdf file, form fields are not identified by the screen reader as they are untagged. 
[image: Form with untagged form fields.]

Ensure that form fields are tagged accurately. 

For example, in the M07_LIAL2130_13_MyNotes_C07.pdf file, form fields are tagged accurately using the <form> and OBJR tags. 
[image: Form tagged accurately using the <form> and OBJR tags.]

Select an accurate format for the field property. 

For example, in the M07_LIAL2130_13_MyNotes_C07.pdf file, “per acre” field is tagged using accurate format property of “number”. 

[image: "Per acre" field marked with an accurate text field property of "Number". ]
Avoid using incorrect format properties to tag a form field.
For example, in the M01_LIAL_CA13E_IR01_5.pdf file, the form field has been tagged with the appropriate properties. 

[image: Form field marked with an inaccurate text field property. ]

User Groups Affected
· Blind users
· Low-vision users
· Keyboard-only users
· Users with learning disabilities

How to test for Accessibility?
To test a form field’s properties, perform the following steps:
1. Open the PDF form that needs to be tested using Acrobat Professional.
2. Double-click on the form field to activate the Properties dialog box.
3. Click on Format Tab and Options Tab to verify the required option, such as date, time, number, alignment, combing, etc.
4. If the condition in step 3 fails, then it is an accessibility violation as per WCAG 2.1 success criteria 3.3.1 at Level A.

[bookmark: _Toc57986898][bookmark: _Hlk57316373]Form Labels
Labels act as a name for the form fields. Based on the label, users understand what information they are required to fill in the respective fields. Labels need to be specified for each form field in an accessible PDF form. Additionally, labels should be unique and descriptive of the field’s purpose. 
Labels should include information about form field constraints, such as date format, file format and any other special instructions that users need to be aware of while filling up the form. Labels even though available visually are not identified as form field’s label for screen reader if they are not specified within "Tooltip” of each form field.
Tip: 
Add appropriate punctuations within the label text and at the end of the label text as it helps screen readers to pause while reading out information for their users.
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.1 Info and Relationships
	A

	3.3.2 Labels or Instructions
	A

	2.5.3 Label in Name
	A

	4.1.2 Name, Role, Value
	A

	2.4.6 Headings and Labels
	AA


How to implement?
This section lists the techniques for adding labels for form fields in an accessible PDF form.
· Add unique and descriptive label for each form field.
· Add labels using “Tooltip” field and specify a unique id in the “Name” field of the General Tab of the Properties dialog box.

Practices to Apply & Avoid
Avoid specifying incomplete, inaccurate, or non-descriptive labels for form fields. 
For example, in the M07_LIAL2130_13_MyNotes_C07.pdf file, form field has an inaccurate and non-descriptive label “undefined_2”.
[image: Form field with a non-descriptive and inaccurate label. ]
Specify accurate label for form fields.

For example, in the M07_LIAL2130_13_MyNotes_C07.pdf file, form field has an accurate and descriptive label “date” for the “date” text field. 

[image: Date field with a descriptive and accurate label. ]

User Groups Affected
Blind users
Low-vision users
Keyboard-only users
· Users with learning disabilities


How to test for Accessibility?
To test labels for form fields in a PDF form, perform the following steps:
1. Open the PDF form that needs to be tested using Acrobat Professional.
2. Double-click on the field to activate the Properties dialog box. 
3. Click on the General Tab and check if label is specified in the “Tooltip” field.
4. Turn on Jaws or NVDA.
5. Press Tab to navigate to the form field and listen if the label is announced.
6. Listen if the label is unique and descriptive of the field’s purpose.
7. If the conditions in step 3 and 5 fail than it is an Accessibility violation as per WCAG 2.1 success criteria 1.3.1 and 3.3.2 at Level A.
8. If the condition in step 6 fails than it is an Accessibility violation as per WCAG 2.1 success criteria 2.4.6 at Level AA.

[bookmark: _Toc57986899][bookmark: _Hlk57316050]Grouping form fields 
Form fields, such as radio buttons are grouped together to communicate to users that they are related, and a group name needs to be specified to help convey the relationship programmatically. In PDF radio buttons can be assigned a group name which results in assistive technologies identifying the name for their users while rendering related form fields. Additionally, different radio buttons are assigned a name which then informs users about their name as well as most importantly how many form fields are grouped together. 
For example, a screen reader will read out group of form fields in the following manner:
1. Gender Male Radio button not checked 1 of 2
2. Gender Female Radio button checked 2 of 2. 
In the above example, Gender is the group name and Male as well as Female are names for radio buttons. Since both Male and Female radio buttons have a common group name, a screen reader renders them as a group of two radio buttons and announces, “1 of 2” and “2 of 2” for their users. 
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	1.3.1 Info and Relationships
	A


How to implement?
This section lists the techniques for specifying group names for related form fields in a PDF form. 
· Specify the group name using the “Name” and “Tooltip” options available in the General Tab of the radio button’s Properties dialog box.
· Specify names of each radio button using the Choice 1, Choice 2 etc. options available in the Options Tab of the radio button’s Properties dialog box. 

Practices to Apply & Avoid
Ensure to use the correct group names and group all relevant options together. 

For example, in the FormGrouping_sample. pdf file we created for the gender option, the options of “Male, female and other” have all been grouped together in the Gender group. 

[image: Radio button options accurately grouped together in one group. ]

Avoid using inaccurate option names to group relevant options together. 

For example, in FormGrouping_sample. pdf file we created for the gender option, the options of “Male, female and other” have all been grouped together in the Gender group. But, the female radio button has been inaccurately named as “choice2”.

[image: Inaccurate option name used to group related options.]

Avoid using different group names to group relevant options together. 

For example, in the FormGrouping_sample. pdf file we created for the gender option, the options of “Female and other” have all been grouped together in the Gender group, but the “Male” choice has been inaccurately grouped under the “Gender1” group. 
[image: Radio button options grouped inaccurately using group names.]
User Groups Affected
Blind users
Low-vision users

How to test for Accessibility?
To check group names of related form fields, perform the following steps:
1. Open the PDF form using Acrobat Reader.
2. Turn on JAWS or NVDA.
3. Navigate to the radio buttons using the Tab key.
4. Listen if the group name and number of radio buttons are announced accurately.
5. If the condition in step 4 fails than it is an accessibility violation as per WCAG 2.1 success criteria 1.3.1 at Level A.

[bookmark: _Toc57986900][bookmark: _Hlk57315542]Form Validation
Form validation messages or error messages help users rectify their mistakes and submit the form successfully. Error messages should be clear, descriptive and easily available for all users to identify their presence. In case of forms including legal, financial or data related actions, provide users with an option to preview and confirm the details before submitting the data.
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	3.3.1 Error Validation
	A

	3.3.4 Error Prevention (Legal, Financial, Data)
	AA

	3.3.3 Error Suggestion
	AAA


How to implement?
This section lists the techniques for adding form validations in a PDF form.
Set up formatting for different input fields, such as date, phone number, password, name etc. with the required parameters.
Add visible form instructions along with the label to ensure that users are aware about the constraints up front.
Set up custom messages (if the default parameters do not offer the customization choices that need to be set for a form field) using the Format Tab of the field’s Properties dialog box.

Practices to Apply & Avoid
Ensure that error messages are identified for form fields.  

For example, in the the 200918_GM_Proxy.pdf file, error message is displayed when users input date in an incorrect format. 

[image: ]
[image: Warning message displayed for incorrect date format. ]

Avoid using form fields for which validation are not defined. 

For example, in the 200918_GM_Proxy.pdf file, error messages are not displayed when users enter date in an incorrect format. 

[image: No warning message displayed for incorrect date format. ]

User Groups Affected
Blind users
Low-vision users
Keyboard-only users
Users with learning disabilities

How to test for Accessibility?
To test for form validations in a PDF form, perform the following steps:
1. Open the PDF form that needs to be tested using Acrobat Reader.
2. Fill up the form fields and enter invalid data in one of the form fields. 
3. Check if validation message is displayed. 
4. If the condition in step 3 fails, then it is an accessibility violation as per WCAG 2.1 success criteria 3.3.1 at Level A.


[bookmark: _Toc57986901]Tabbing order
Keyboard-only users rely on keystrokes for interacting with PDF forms. They use the “Tab” and “Shift + Tab” keystrokes to navigate to the next and previous form field, respectively. A logical tabbing order needs to be specified for PDF forms to allow keyboard-only and screen reader users access form fields in a meaningful order. In the absence of a logical tabbing order, it becomes difficult for keyboard-only and screen reader users to access the form fields. 
[image: ]
	WCAG Success Criteria
	WCAG Conformance Level

	2.4.3 Focus Order
	A


How to implement?
This section lists the techniques for defining a logical tabbing order for form fields in a PDF form. 
· Arrange the form fields in a meaningful order in the Prepare Form section. 
· Form fields should receive tab focus in left to right and top to bottom order.
Tip: 
Visual order of form fields does not always result in a logical tabbing order. 
Practices to Apply & Avoid
Avoid tagging fields in an incorrect order. This results in inaccurate tabbing order. 
For example, in the 200918_GM_Proxy.pdf file, the form has an inaccurate and illogical tabbing order. The tabbing order is as follows:
1. “Amendment to the directors remuneration policy to permit the grant of the Coinvestment Award: For” Radio button
2. “Date”
3. “Signature”
4. “Amendment to the directors remuneration policy to permit the grant of the Coinvestment Award: Against” Radio button
5. “Amendment to the directors remuneration policy to permit the grant of the Coinvestment Award: Vote withheld” Radio button
[image: Form with inaccurate tabbing order.]
Arrange the fields correctly to ensure a logical tabbing order. 

For example, in the 200918_GM_Proxy.pdf file, the form has an accurate tabbing order. The tabbing order is as follows:
1. “Amendment to the directors remuneration policy to permit the grant of the Coinvestment Award: For” Radio button
2. “Amendment to the directors remuneration policy to permit the grant of the Coinvestment Award: Against” Radio button
3. “Amendment to the directors remuneration policy to permit the grant of the Coinvestment Award: Vote Withheld” Radio button
4. “Date”
5. “Signature”

[image: Form with an accurate tabbing order.]
User Groups Affected
Blind users
Low-vision users
Keyboard-only users
Users with learning disabilities

How to test for Accessibility?
To test the tabbing order of a PDF form, perform the following steps:
1. Open the PDF form that needs to be tested using Acrobat Reader.
2. Navigate the form using the Tab and Shift + Tab keys.
3. Observe if the form fields receive focus in a logical order. 
4. If the condition in step 3 fails, then it is an accessibility violation as per WCAG 2.1 success criteria 2.4.3 at Level A.

The following table lists JAWS and NVDA commands for reading PDF forms:
	Function
	JAWS command
	NVDA command

	Open the Forms list dialog
	Insert + F5
	–

	Turn on Forms Mode (JAWS) or Focus Mode (NVDA)
	Enter
	Insert + Spacebar

	Turn off Forms Mode (JAWS) or Focus Mode (NVDA)
	Numpad Plus
	Insert + Spacebar

	Go to Next Button
	B
	B

	Go to Previous Button
	Shift + B
	Shift + B

	Go to Next Combo box
	C
	C

	Go to Previous Combo box
	Shift + C
	Shift + C

	Go to Next Edit field
	E
	E

	Go to Previous Edit field
	Shift + E
	Shift + E

	Go to Next Form field
	F
	F

	Go to Previous Form field
	Shift + F
	Shift + F

	Go to Next Radio button
	A
	R

	Go to Previous Radio button
	Shift + A
	Shift + R

	Go to Next Checkbox
	X
	X

	Go to Previous Checkbox
	Shift + X
	Shift + X




[bookmark: _Toc57986902]SCANNED DOCUMENTS
Scanned documents are similar to photographs that have been saved in a PDF format. There are millions of scanned PDF document floating on the web today. When screen reader users open a document, no content is announced for them and they cannot access the file at all. Scanned documents are blockers which restrict users from accessing the content of the file. Often organizations have a mandate to upload their documents digitally and the easiest route that they adopt is to scan the hard copy of a document and save it as a “.pdf” file.
Many OCR software are available that users with visual impairments rely on for accessing the contents of the scanned document. Most of these software’s fail to reliably recognize the content for users with visual impairments. This results in users being deprived of vital information. 
Some of the OCR application can access text and they do not render text in tables, columns, images of text reliably. Students often are presented with notes in scanned PDF format which results in they not being able to get access to their notes. What is required is to OCR, proof read and tag the document in order for screen readers and other assistive technologies to render the information accurately for their users.
To make scanned PDF documents accessible basically 3 main steps need to be carried out:
1. OCR the document to ensure that the content can be selected.
2. Proof read the document for errors.
3. Add appropriate tags to make the content accessible. 
Tip: 
Proof read should be done using automated tool as well as manually to yield accurate results. 

Let us take a file calculator_review_card (54).pdf and perform each of the above steps to make a scanned PDF document accessible.
1. Open the scanned document in adobe acrobat Professional DC.
2. In a scanned pdf there are no tags and text, or any content cannot be selected.

[image: Scanned document with no tags and content that can not be selected. ]

3. Select the “Recognize text” tool from the tool bar.
4. Specify the language and the pages and the click on the “Recognize Text” option.
5. After performing this step, the content will be selectable but there will still be no tags.

[image: Scanned document with no tags but with content that can be selected. ]
6. In order to check for spelling mistakes, select the “correct recognized text” option from the “Recognize text” drop down option. 
7. This will proof read the pdf. 


[image: Screen shot of Adobe Acrobat box saying "The document does not contain any suspects".]
8. In order to create tags, in the tools panel on the right side, select action wizard.
9. Within the action wizard tool, select the option of “Make Accessible”

[image: "Make accessible" option in the action wizard list. ]

10. After selecting “Make Accessible”, click on the “Start” button to make the file accessible.

[image: "Start" button in the make accessible panel. ]

11. After clicking on start, a description box opens to edit the title, Subject, Author and keywords. Click on “OK” to go to the next step.


[image: Highlighted "OK" button in the "Description" box along with options to edit the "Title", "Subject", "Author" and "Keywords".]

12. After clicking on “OK” a recognize-text box opens. Check the document language, select the Output and Down sampling size and click on “OK”. 
[image: "Recognize Text-General Settings" box with a highlighted "OK" button along with options to specify the "Document Language", "Output" and "Downsample To".]

13. After clicking on “OK”, another box opens to understand the file format. Click on “Yes, Detect Form Fields” if it’s a file that contains forms or “No, Kkip this Step” if it does not contain forms.

[image: "Yes, Detect Form Fields", "No, Skip this Step" and "Cancel" buttons in the in the "Adobe Acrobat" box.]

14. After selecting the form or non-form option, set the reading language of the file and click on “OK”
[image: "Set Reading Language" box with a highlighted "OK" button and option to change "Language".]


[bookmark: _Toc57986903]TEST FOR ACCESSIBILITY
We have thus far learnt different techniques for tagging page elements for making PDF documents accessible. Once the document is made accessible, it needs to be evaluated for accessibility. A PDF document can be evaluated for accessibility with manual and automated testing. To evaluate accessibility of a PDF document there are several automated tools available. 
Two of the leading automated tools are Acrobat Full Check – Accessibility Checker by Adobe which can be accessed from Acrobat Professional DC and PAC Checker (PDF Accessibility Checker) by a Swiss not for profit organization Access for All. We will be learning about both these applications in this section.
[bookmark: _Hlk57312531]Tip: Use a combination of automated and manual testing for checking a PDF document!

Tip:  
Use a combination of automated and manual testing for checking a PDF document!

[bookmark: _Toc57986904]Adobe Accessibility Checker
To check for accessibility using Adobe Acrobat Professional DC perform the following steps: 
1. Open the pdf file in Acrobat Professional DC. 
2. Click on the “Tools” tab. 
3. Click on the “Accessibility” option.  

[image: "Accessibility" option highlighted in the "Tools" tab. ]

4. Select “Full Check” from the list of options. 
5.  The “Accessibility Checker Options” dialog opens, click on “Start Checking” button.

The Accessibility Checker dialog provides different options to set up the test and manner in which the output is displayed. Following options are available:
Accessibility permission flag is set
Document is not image-only pdf
Document is tagged pdf
Document structure provides a logical reading order
Text language is specified
Document title is showing in title bar
Bookmarks are present in large documents.
Documents have appropriate color contrast.

[image: "Start Checking" button highlighted in the "Accessibility Checker Options" box.  ]

For example, in the 2020-Chief-Executives-Strategic-overview.pdf, there are many accessibility issues which need to be rectified. Accessibility issues identified in the file include:
Document (4 issues)
· Accessibility permission Flag- Passed
· Image- only PDF- Passed
· Tagged PDF- Passed
· Logical Reading order- Needs manual check
· Primary language- Failed
· Title- Failed
· Bookmarks- Passed
· Color contrast- Needs manual check
Page Content (1 issues)
· Tagged content- Passed
· Tagged annotation- Passed
· Tab order- Failed
· Page 1
· Page 2
· Page 3
· Character encoding- Passed
· Tagged multimedia- Passed
· Screen flicker- Passed
· Scripts- Passed

[image: Screenshot of Accessibility Checker with multiple errors. ]
All the above issues need to be rectified and then again check the document for accessibility. Once all the errors are rectified, running the evaluation will display the following output:
For example, in the 2020-Chief-Executives-Strategic-overview.pdf, there are many accessibility issues which need to be rectified. Accessibility issues identified in the file include:
Document (2 issues)
· Accessibility permission Flag- Passed
· Image- only PDF- Passed
· Tagged PDF- Passed
· Logical Reading order- Needs manual check
· Primary language- Passed
· Title- Passed
· Bookmarks- Passed
· Color contrast- Needs manual check
Page Content
· Tagged content- Passed
· Tagged annotation- Passed
· Tab order- Passed
· Character encoding- Passed
· Tagged multimedia- Passed
· Screen flicker- Passed
· Scripts- Passed


[image: Screenshot of Accessibility Checker with solved issues.]
[bookmark: _Toc57986905]PAC3 Accessibility Checker
PDF Accessibility Checker (PAC) is a free Desktop based tool to check PDF documents for conformance with PDF/UA standards. PAC3 is a Windows based tool developed by Swiss Not for Profit Organization Access for All that checks the PDF for:
· PDF/UA conformance
· Logical tag Structure
· Screen reader Preview
Once you have downloaded and installed PAC, perform the following steps to start testing a PDF document:

1. Launch PAC3 software.
2. Select the file to check and upload it on the software. 

[image: PAC3 software with highlighted option to upload file. ]
3. Check the report. Basic information of the file will be displayed such as:
a. Title
b. Filename
c. Language
d. Tags
e. Pages
f. Size
g. Summary Report
[image: PAC3 software with highlighted file information.]

4. Check the details of errors by clicking on the “Result in Details” option. 

[image: ]

5. Create summary report by clicking on the “Summary Report as PDF” option. The Summary Report displays PDF/UA conformance output along with the test results based on different checkpoints, such as:
a. PDF Syntax
b. Fonts
c. Contents
d. Embedded Files
e. Natural Language
f. Structure Elements
g. Structure Tree
h. Role Mapping
i. Alternate Description
j. Metadata
k. Document Settings
[image: PAC3 software with highlighted "Summary Report as PDF" option.]
6. Results for each checkpoint are categorized in:
a. Passed
b. Warned
c. Failed

7. In case, there are errors, solve the errors and recheck the file using PAC3 software. 
8. The detailed report comprises of type of errors and warnings for each checkpoint along with:
a. Number of errors and warnings for each type.
b. Snapshot of page on which the error or warning is found.
For example, in the Pearson-Indicative-allocation-and-impact reporting-template-Final-v3.pdf, there are many accessibility issues which need to be rectified. Accessibility issues identified in the file include:
· PDF Syntax- Passed
· Fonts- Passed
· Content- Failed
· Natural Language- Passed
· Structure elements- Failed
· Structure Tree- Warning
· Role Mapping- Passed
· Alternate Descriptions- Failed
· Metadata- Failed
Document Settings- Passed

[image: PAC3 software with errors in the file. ]

9. Logical structure option of PAC checker displays the tag structure of the file in the form of a tree node. The following steps outline how to evaluate the tag structure:
a. Click on Logical Structure button.
b. Click on any tag displayed in a tree node on the left to view its Properties on the right.
[image: ]
10. The Screen Reader Preview displays the entire file contents as it would be rendered by a screen reader. The Screen Reader Preview window displays:
a. Tags used for each element.
b. Tags are color coded for easy identification.
c. Element tag is displayed on the left with its contents on the right.
d. File content is displayed in the order as it will be read out to a screen reader user.
[image: ]

Once the errors are solved and the file is checked again using PAC3 following output is displayed:
· PDF Syntax- Passed
· Fonts- Passed
· Content- Passed
· Natural Language- Passed
· Structure elements- Passed
· Structure Tree- Passed
· Role Mapping- Passed
· Alternate Descriptions- Passed
· Metadata- Passed
· Document Settings- Passed
[image: ]


[bookmark: _Toc57986906]APPENDIX
This section lists down links to different resources that offer useful guidance for authoring accessible PDF documents:
	Accessibility Resource
	Where it can be found?

	Web Content Accessibility Guidelines 2.1
	https://www.w3.org/TR/WCAG21/

	WCAG PDF Techniques
	https://www.w3.org/TR/WCAG20-TECHS/pdf

	PDF/UA Standard
	https://www.pdfa.org/resource/the-matterhorn-protocol-1-02/

	Pearson Accessibility Guidelines
	https://www.pearson.com/accessibility-guidelines.html

	Color Contrast Analyser
	http://www.paciellogroup.com/resources/contrast-analyser.html

	Acrobat Pro DC Accessibility Checker
	https://www.adobe.com/accessibility/products/acrobat/using-acrobat-pro-accessibility-checker.html 

	PAC Checker
	https://www.access-for-all.ch/en/pdf-accessibility-checker.html

	Alt Decision Tree
	https://www.w3.org/WAI/tutorials/images/decision-tree/
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indicators

205 Glossary of major products
andservices

208 Shareholder information
1BC Principal offices worldwide

Our reporting structure
From 2020, we will be operating within
anewstructure. This s outlined on p12.
Inthis annual report, the ‘Strategy”
section follows our new structure.

The Financial review' and ‘Operating
performance review’ sections continue
to use our geographical reporting
structure - North America, Core and
Growth - as these relate to our

2019 performance. Nextyear's
reporting will use our new operating.
Structure throughout.

Strategicreport
The strategic report, up to and including.
S0, is formed of three sections:
‘Overview, ‘Our strategy’and ‘Our
performance’, and was approved for
issue by the Board on 6 March 2020

and signed onits behalf by:

P -

Coram Williams
ChiefFinancial Officer
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the next 20 years. | believe that even more
strongly today. The exponential pace of
digital change - and the impact of artificial
intelligence and machine learning on the
world of work - will require all of us to acquire
fresh knowledge and learn new skills
throughout an ever-longer working life.

Laying the foundations for growth

In 2010, we had a $2bn US Higher Education
Courseware business, split 75:25 between

printand digital. By 2022, we expect to have
an almost fully-digital' S Higher Education
Courseware business well set to grow again.

are willing to pay - $80 for a fully adaptive
platform-based course; $40 for an eText.

So, why has our US Higher Education
Courseware revenue halved in ten years?

If our digital products are now deeply
embedded in the workflow of our customers,

Deconstructing decades of complexity to build the foundations for Pearson's transformation
into a platform-based company, to become the winner in digital learning.

Global property portfolio reduced by net 30 properties

€.2.500 applications decommissioned
8l data centres closed

1ERP system running 80% of Group revenue

c.£1bn of costs removed since 2013

Pearson

1 The core U Higher Education Courseware business is expected to be almost entirely digital. We also have an Advanced Placement business selling higher education
contentinto US schools. This, together with several other smaller, non-college channels, comprises roughly ¢.$200m of print revenue which has been broadly stable.
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North America

Market summary

Our largest market includes all
50 US states and Canada.

Sales
£2.534m

Adjusted operating profit

£36Im

Accelerated Pathways

Accelerated Pathways partners with
employers to implement educational
benefits programmes that provide our
clients’ employees with lifelong learning
opportunities. These solutions may include

Revenue declined 3% in underlying terms,
primarily due to US Higher Education
Courseware declining 12%, and Student
Assessment, which declined slightly.
Offsetting that, we saw good growth in
Virtual Schools, OPM and Professional
Certification (VUE) revenue. Headline revenue
decreased due to disposals, partly offset

by FX gains.

Adjusted operating profit declined 3% in
underlying terms, due to the impact of lower
sales, inflation and other operating factors
partially offset by restructuring savings.
Headline profit was flat on last year, with the
impacts on adjusted operating profit offset
by the benefits of FX and IFRS 16 adoption.

Courseware

In US Higher Education Courseware, a
revenue decline of 12%, with print declining
close to 30%, was partially offset by modest
growth in digital. In 2019, the weaker
performance was driven by a number

of factors:

We are also launching a direct-to-learner
Pearson eText in 2020, with enhanced features.

US Higher Education Courseware digital
registrations, including eBooks, declined 2%.
Good registration growth in Revel, up 9%,
was offset by continued market pressure

in Developmental Mathematics and the
planned retirement and deprioritisation

of long-tail products.

We continue to make good progress with
Inclusive Access signing 162 new institutions
in 2019, taking the total not-for-profitand
publicinstitutions served to 779. Including
80 longer-standing contracts with for-profit
colleges, we now have direct relationships
with over 850 institutions.

In2019, we served 1.8m Inclusive Access
enrolments up from 1.4min 2018, making up
9% of 2019 US Higher Education Courseware
revenue, up 19% on 2018 on a like-for-like
basis, excluding the 80 for-profit colleges.

Assessment




image96.png
Bookmarks X

B- W le B

b [& Annual report and accounts 2019

v [ Focused on digital, lifelong
learning

[& Who we are
[& Who we are
[& Our purpose
[& Our capabilities

[& Our vision

‘Our commitment to
sustainability and learning

tcomas

[ Focused on digital, lifelong learning

'Who we are

We are the world's learning company, operating in

70 countries around the world, with more than 22,500
employees. We provide content, assessment and digital
services to schools, colleges and universities, as well as
professional and vocational education to learners to help
increase their skills and lifelong employability prospects.

We aim to support learners throughout their lifetime
for every moment that matters - whether this is exam
preparation and success, graduating from university,
getting a new job, studying for a postgraduate degree,
changing career, or looking for a new challenge.

Our purpose |s to help people make progress in their

lives through learning.

Ourvisiollis to have a direct relationship with millions
of lifelong learners and to link education to the way
people aspire to live and work every day. To do that,

we will collaborate with a wide group of partners to
help shape the future of learning.

Our capabilities Include combining world-class

educational content and assessment, powered

by services and technology, to enable more effective
teaching and personalised learning at scale.

Our capabilities are based on our deep expertise

in how people learn.
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On 24 August 2020, the Company announced the prospective appointment of Andy Bird as Pearson's new Chief Executive and its intention to seek shareholder
‘approval of a resolution to amend Pearson's Directors’ Remuneration Policy to permit the grant of a co-investment share award to him (the “Resolution”).

Pearson held a General Meeting at 12 noon today in order to seek approval of the Resolution. The Company is pleased to confirm that the Resolution, as set out in the
Gircular and Notice of General Meeting dated 28 August 2020, was proposed and approved on a poll.
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The Remuneration Committee presents the 2020 Directors’ Remuneration Policy (2020 Policy), which will be put to
shareholders for binding vote at the AGM to be held on 24 April 2020. Subject to shareholder approval, the effective
date of this Policy will be 24 April 2020. However, it is proposed, subject to approval at the AGM, that changes to
Executive Director incentives be made effective from the start of the 2020 performance periods. The intention of
the Committee is that the Policy will remain in place for three years from the date of its approval.

In 2019, Pearson reviewed its remuneration philosophy and developed a set of remuneration principles that govern the whole organisation.
We have evolved our Remuneration Policy to align with these updated remuneration principles:
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On 24 August 2020, the Company announced the prospective appointment of Andy Bird as Pearson's new Chief Executive and its intention to seek shareholder
‘approval of a resolution to amend Pearson's Directors’ Remuneration Policy to permit the grant of a co-investment share award to him (the *Resolution”).

Pearson held a General Meeting at 12 noon today in order to seek approval of the Resolution. The Company is pleased to confirm that the Resolution, as set out in the
Gircular and Notice of General Meeting dated 28 August 2020, was proposed and approved on a poll.

The table below shows the results of the poll for the Resolution. Pearson’s issued share capital at the voting record date was 752,971,544 ordinary shares of 25p each.
‘The proportion of the Company’s issued share capital represented by those votes cast is approximately 82%.

Resolution Votes Forand | % votes cast | Votes %votes | Totalvotes | % of Votes
Discretionary | _ Forand Against cast cast issued Withheld/
Discretionary Against | (excluding | capital | Abstentions®
votes voted
withheld)
Amendment to the Directors' Remuneration Policy | 417,060,992 6722% | 203423538 | 3278% | 620484530 | 8240% 370,074
to permit the grant of the Co-investment Award
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Pearson plc
Schedule of matters reserved to the board

The following are matters reserved to the board:

1.

Responsibility for the overall leadership of the company and setting the
company’s purpose, values and standards including monitoring and promoting
the culture.

Determining the company’'s strategy in consultation with management and
reviewing performance against it.

Any decision to cease to operate all or any material part of the company’s
business.

Major changes to the company's corporate structure (with appropriate
exceptions for intra-group transactions), management and control structure or
its status as a plc.
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2.

Identify the functional unit of the kidney and explain
its role in renal function.

A patient is prescribed a medication that inhibits the
release of ADH. How would you expect this medica-
tion to affect the patient’s urinary output?

On the basis of the anatomy of the female genitouri-
nary system, identify two reasons women are at an
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Vigeo Eiris was commissioned to provide an independent opinion (hereafter the “Second Party Opinion” or “SPO")
on the sustainability credentials and management of the Social Bond (the “Bond") to be issued by Pearson (the
“Issuer”) in compliance with the Social Bond Framework (the “Framework’) created to govern their issuance.

Our opinion is established according to Vigeo Eiris' Environmental, Social and Governance (‘ESG’) exclusive
assessment methodology and to the latest version of the ICMA's Social Bond Principles (the “SBP”) voluntary
guidelines edited in June 2018.

Our opinion is based on the review of the following components:

1) Issuer: we assessed the Issuer's ESG performance (evaluated in September 2019), its management of
potential stakeholders-related ESG controversies and its involvement in controversial activities?.

2) Issuance: we assessed the bond issuance, including the coherence between the Framework and the
Issuer’s social commitments, the Bond’s potential contribution to sustainability and its alignment with the
four core components of the SBP 2018_

Our sources of information are multichannel, combining data from (i) public information gathered from public
sources, press content providers and stakeholders, (i) information from Vigeo Eiris exclusive ESG rating database,
and (iii) information provided by the Issuer.

We carried out our due diligence assessment from August 5%, 2019 to May 12*, 2020. We consider that we were
provided with access to all the appropriate documents we solicited. To this purpose we used our reasonable efforts
to verify such data accuracy.
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Setting the agenda, style and tone of board discussions to promote a culture of effective
decision-making, openness and constructive debate.

Ensuring that he is fully informed about all issues on which the board will have to make a
decision, through briefings with the Chief Executive, the company secretary, and members of
the executive management s appropriate.

Ensuring that directors receive accurate, timely and clear information.

Ensuring clear structure for, and the effective running of, board committees.

Ensuring effective implementation of board decisions.
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As part of the report, the Committee reviewed Pearson’s readiness
for the California Consumer Privacy Act (which came into effect
atthe start of 2020), and an overview of privacy laws which would
soon be introduced in other jurisdictions in which Pearson operates.
Key aspects of Pearson's data privacy programme were also
considered, including:

> the principles and priorities underpinning Pearson's multi-year
data privacy strategy

> the emphasis on ‘privacy by design’in the development of new
Pearson products and platforms

> the advancement of processes to respond to user/data subject
requests, including the rights to access, correct and delete data

> the review and enhancement of the data privacy
governance structure

In addition, an update on the AimsWeb 1.0 security incident
was provided,

Theinformation security report allowed the Committee to consider
the progress made in recent years. In considering the current status
of the information security programme, the Committee noted the
frameworks which had been putin place in respect of:
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Internal control and risk management

Ourinternal controls andrisk oversight are monitored and continually
improved to ensure their compliance with FRC Guidance.

The Board is ultimately accountable for effective risk management in
Pearson and determines our strategic approach to risk. It confirms
our organisational risk management framework as well as our risk
appetite targets. Twice yearly it receives and reviews reports on

the status of the top Group-wide risks. It is supported in the
following ways:

, the Audit Committee is responsible for overseeing internal controls
within Pearson which includes determining the risk appetite
(recommended by Pearson Executive management), reviewing
and commenting upon key risks, and ensuring that risk
management is effective.

» Pearson's Executive and leadership teams are responsible for
identifying and mitigating principal risks.

) leaders and managers at alllevels in Pearson are responsible:
for managing risk in their area of responsibility, including the
identification, assessment and treatment of risk.

 the Organisational Risk and Resilience team owns the overall
risk management framework for the company and facilitates
consolidated reporting onrisk.

1§ consolidated reporting on risk.
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Long-Term Incentive Plan (LTIP)

Performance targets for the 2020 awards to Executive Directors

At the time the annual report was signed off for publication, the strategic goals for the company
over the next three years were still under development by the Board. The targets for the 2020
LTIP grant are therefore disclosed below and will be disclosed again in the RNS announcement
accompanying the grant, which is expected to be made in May as normal.

The award will vest on 1 May 2023 subject to the following performance conditions:

1/3 of the award will be based on Pearson’s earnings per share (EPS) in 2022;
1/3 of the award will be based on Pearson’s net return on invested capital (Net ROIC) in

2022; and

1/3 of the award will be based on Pearson’s total shareholder return (TSR) performance
relative to the constituents of the FTSE 100 index over the three-year period 1 January
2020 to 31 December 2022
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. Meetings

Chairing board and general meetings.

Running the board and ensuring its effectiveness in all aspects of its role, including regularity
and frequency of meetings.

Setting the board agenda, taking into account the issues and concerns of all board members.
The agenda should be forward looking, concentrating on key themes of strategy, governance,
operating effectiveness and people development.

Ensuring that there is appropriate delegation of authority from the board to executive
management.

Ensuring that the directors receive accurate, timely and clear information for the board
meetings. This includes information on the company’s current performance, to enable the
board to take sound decisions, monitor effectively and provide advice to promote the success
of the company.

Managing the board to allow enough time for discussion of complex or contentious issues.
Ensuring a clear structure for, and the effective running of, board committees.

Promoting the highest standards of corporate governance.

Ensuring that directors (particularly non-executive directors) have sufficient time to consider
critical issues and obtain answers to any questions or concerns they may have and are not
faced with unrealistic deadlines for decision making.





image48.png
v @
v @ <>
v @ <LBody>
5§ 4 Relations with shareholders
v @ <>
v @ <LBody>
& * Ensuring that the views of shareholders are c¢
v @ <>
v @ <LBody>
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Relations with shareholders

Ensuring that the views of shareholders are communicated to the board as a whole so that all
directors develop an understanding of their views.

Seeking regular contact with major shareholders to understand their views on governance and
performance against strategy.

Ensuring effective communication with shareholders.

AGM

Arranging the board to be available to answer questions at the AGM.
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Operation

Opportunity

Performance conditions and period

Base salariesare setto provide the
appropriate rate of remuneration
forthe job, takinginto account
relevant recruitment markets,
businesssectorsand
geographicregions.

Base salariesare normally
reviewed annually takinginto
account: general economicand
market conditions; the level
ofincreases made acrossthe
company asawhole; particular
dircumstances such as changes
inrole, responsibilities or
organisation; the remuneration
andlevel of increasesfor
executivesinsimilar positionsin
comparable companiesin both
the UK, US and internationally;
andindividual performance.

While thereis no maximum salary
level or maximum increase that
may be offered, salary increases
will normally be in line with typical
increases awarded to other
employees in the Group.
However increases may be above
this level in certain circumstances
suchas:

> Where a new Executive Director
has been appointed tothe Board
atalower thantypical market
salary to allow for growthinthe
role then larger increases may
be awarded tomove salary
positioning closer to typical
market level as the Executive
Director gains experience.

> Where an Executive Director
has been promoted or hashada
changein responsibilities.

> Wherethere hasbeena
significant change in market
practice or where there has been
asignificant changein the size
and/or scope ofthe business.

None, although performance
of boththe companyand the
individual are taken into account
when determining an appropriate
level of base salaryincrease
eachyear.

Allowances and benefits
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Operation

Opportunity

Performance conditions and period

Base salariesare setto provide the
appropriate rate of remuneration
forthe job, takinginto account
relevant recruitment markets,
businesssectorsand
geographicregions.

Base salariesare normally
reviewed annually takinginto
account: general economicand
market conditions; the level
ofincreases made acrossthe
company asawhole; particular
dircumstances such as changes
inrole, responsibilities or
organisation; the remuneration
andlevel of increasesfor
executivesinsimilar positionsin
comparable companiesin both
the UK, US and internationally;
andindividual performance.

While thereis no maximum salary
level or maximum increase that
may be offered, salary increases
will normally be in line with typical
increases awarded to other
employees in the Group.
However increases may be above
this level in certain circumstances
suchas:

> Where a new Executive Director
has been appointed tothe Board
atalower thantypical market
salary to allow for growthinthe
role then larger increases may
be awarded tomove salary
positioning closer to typical
market level as the Executive
Director gains experience.

> Where an Executive Director
has been promoted or hashada
changein responsibilities.

> Wherethere hasbeena
significant change in market
practice or where there has been
asignificant changein the size
and/or scope ofthe business.

None, although performance
of boththe companyand the
individual are taken into account
when determining an appropriate
level of base salaryincrease
eachyear.
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10.

11

Briefly describe the ways in which prokaryotic DNA differs from eukaryotic cells in terms of
quantity of DNA, location, and so forth.

A resistant cell produced by some prokaryotes that resists harsh conditions is referred to as a(
n) .

‘An organism’s mode of nutrition is determined by and

‘Complete the following table, which compares the different modes of nutrition.

A scientist discovers a new prokaryote that lives in the thermal ponds in Yellowstone National
Park. Initial observations indicate that the organism contains a chlorophyll-like pigment, and
an enzyme similar to what plants use to fix atmospheric CO2. What mode oft nutrition does
this organism likely use?

Prokaryotes that have formed an organized colony that can adhere to almost any surface are
known as a(n)

When you wake up each morning, your mouth has a filmy coating on its surfaces including
vour teeth. What is the primarv reason why vou brush vour teeth as opposed to iust rinsing
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10.

‘Complete the following table, which compares the different modes of nutrition.

Description

Example

A scientist discovers a new prokaryote that lives in the thermal ponds in Yellowstone National
Park. Initial observations indicate that the organism contains a chlorophyll-like pigment, and
an enzyme similar to what plants use to fix atmospheric CO2. What mode oft nutrition does
this organism likely use?

Prokaryotes that have formed an organized colony that can adhere to almost any surface are
known as a(n)





image53.png
> @
> @
v @ <P

The targets (and outcomes) for performance against each of the strategic measures are shown in the table and supporting narrative below:
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Softotal
Strategic priority  Measure funding  Threshold Trget Max Outcome
Gainshare  Growthin digitaland 5% 62.5% 63% 64.0% Digital and digitally-enabled sales increased
through digitally-enabled sales asa +0.5%on ¢1%on @2%on 1066.3% of total revenues in 2019vs 62%
digital proportion of revenues 2018resul)  2018result) ~ 2018result)  in2018.
transformation pugiea) platforms - 5% Critical Critical Allmilestones  Aidaapp and Revel both launched and
delivery ofkey 2019 milestones  milestonesand  and deliverables available for commercial use.
milestones related to ontrack key deliverables on track Progress made against other milestones
Alapp and Revel pilots ontrack hasresulted in an accelerated innovative
product roadmap. which willdrive cumulative
incrementalvalue ata lower cost thanthe
original plan over future years.
Growing Investin growing. 5% +5%revenue  +7.5%revenue +10%revenue  Our growth businesses - Pearson VUE,
market market opportunities - growth growth growth Virtual Schools, OPM and PTE Academic -
opportunities  total revenue growth grew by 8% in revenue. These growth
businesses will continue to grow in 2020,
asweinvestin new forms of online education,
in better, smarter, online assessments, in new
Alinspired direct.to learner apps. andin
shifting Pearson's focustolink education and
employability with the workplace.
Becoming  TheEnablingProgramme 5% critical aritical Allmilestones  Good progress was made againstthe
simpler, more  (TEP) - linked to key milestones  milestones  and deliverables business value realisation plan but further
efficientand  deliverables/milestones ontrack andkey ontrack workis stillneeded to sustain fixes and
sustainable  including (successful) deliverables overcome more complicated issues.
deployment of Wave 3 ontrack Wave 3was deployed successfuly.

Release, progress on
RoW and Red Amber
Green (RAG) status of
value realisation plan

Due to significant progress against strategic goals in 2019, an above target result was achieved under these measures. However, as the financial
underpin was not met therefore there will not be a payout under the strategic measures for 2019.
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Executive Directors’ annual incentive payments for 2019*
> B <0~ The following table summarises the performance targets and performance against these targets for the 2019 award which resulted in a nil payout
s &5 <D> for both the Chief Executive and CFO.
Overall outcome
> & <TD>
Performance range Payout
> § <10~ % ormaxbonus
Performance measure sortotal Threshold Target Max  Actuslresuis  opportunity
> B <0~ Adjusted operating profit 20% £588m £612m £671m £581m 0%
v &8 <TR> Sales 20% £3902m £3976m £4,050m £3,869m 0%
< "
TS Operating cash flow 20% £401m £43am £492m £307m 0%
Strategic measures 20% See below 0%
> &8 <To> 100% 0%
> &8 <TD> Note T-Operating cash flow = measured post-restructuring, Operating cash flow pre-restructuring = E418m.
Note 2: See below for performance against strategic measures.
> B <> Note 3: The outcomes under all measures have been reviewed by internal audit.
s &8 <R Performance against strategic measures
The targets (and outcomes) for performance against each of the strategic measures are shown in the table and supporting narrative below:
> B8 <TR>
s5oftotal
> & <TR> Strategic priority _ Measure funding_ Threshold Terget Max Outcome
Gainshare  Growthin digitaland 5% 62.5% 63% 64.0% Digital and digitally-enabled sales increased
> &8 <TR> through digitally-enabled sales as a (+0.5%on (+1%o0n (+2%on 066.3% of total revenues in 2019vs 62%
. digital proportion of revenues 2018result)  2018resulty  2018result)  in2018.
<TR> 8
> H transformation pyoi i oot forms 5% Critical Critical Allmilestones  Aida app and Revel both launched and





image57.png
The target ranges were
expectations of perforn]

The level of awards grar|
245% of salary for the Cf
under the adjusted EPS

The overall outcome ba
company atthe AGM, b

The targets and perforn

erformancemeasure | %

hdjusted EPS

0IC

elative TSR

Relative TSR was measul

The Committee very car
against the delivery of s
programme, aswell as
there had been a signifi
company has faced ovef

Table Cell Properties

Type
@ Header Cell
O Data Cell

Attributes

Associated Header Cell IDs: V1

B —

Column Span: |1

X ptoaccountinternal and external

lary for the Chief Executive and
lerformance was also reduced

rever, Coram Williams will leave the

Row Span: [1 Vesting
% | sofcoma]
Actusl Jachievement award
57.8p So% TS,
D: [C1 5.2% 57% 171%
] 720utofgs 0% o
E Total 32.7%

hareholder experience, progress
tion delivered by the simplification
| The Committee considered whether

oK Cancel

withstanding the challenges the

luded that the vesting outcome was a

fair reflection of the proy
vesting outcome.

erefore exercised to adjust the




image58.png
v [ <Table>

v &5 <TR>
> B <TH>
> B <TH>
> B <TH>
> B <TH>
> B <TH>
v &5 <TR>
=5 <TH>
=5 <TH>
=5 <TH>
=5 <TH>
=5 <TH>
=5 <TH>
=5 <TH>
=5 <TH>

vV vV V.V VoV oV

delivered over the three-year period from 2017 to 2019.

The target ranges were set following extensive consultation with our major shareholders n 2017, and took into account internal and external
expectations of performance when the awards were made.

The level of awards granted to Executive Directors in 2017 was reduced by approximately 30% to 275% of salary for the Chief Executive and
245% of salary for the CFO to reflect the dedline in share price at the time. The level of payout at threshold performance was also reduced
under the adjusted EPS and ROIC measures.

The overall outcome based on performance achieved against targets is 32.7% of the maximum awards. However, Coram Williams will leave the
company at the AGM, before the 2017 LTIP vests, and therefore his award willlapse in full.

The targets and performance against these targets are as follows:

> B8 <TR>
> B8 <TR>
> B8 <TR>
y & <TR>

Performance range Vesting
Payoutat  Payoutat  Payoutat % Softotal

Performance measure _Softotal __ Threshold Target __ Maximum __threshold target__maximum Actual _achievement ‘award
Adjusted EPS 40% 55p 62p 75p 15% 75% 100% 57.8p 39% 15.6%
ROIC 30% 4.5% 5.5% 7.5% 15% 75% 100% 5.2% 57% 17.1%

Upper

Relative TSR 30%  Median NA  quartile 25% N/A 100% 720utof95 0% 0%
100% Total 32.7%

Relative TSR was measured against the constituents of the FTSE 100 atthe start of the performance period.

The Committee very carefully considered the vesting outcome in the context of financial performance, the shareholder experience, progress
against the delivery of strategic initiatives including the business transformation and sustainable cost reduction delivered by the simplification
programme, as well as reviews of talent, diversity, culture, customer experience and sustainability agendas. The Committee considered whether
there had been a significant negative event (such as an ESG event) which would warrant an adjustment. Notwithstanding the challenges the
company has faced over the last year in the US Higher Education Courseware business, the Committee concluded that the vesting outcome was a
fair reflection of the progress the company has made over the last three financial years. No discretion was therefore exercised to adjust the
vesting outcome.

Overall, the Committee considers that the Remuneration Policy has operated s itintended during 2019 and that the pay outcomes are aligned
with the experience of shareholders and other stakeholders over the relevant performance period.

Long-term incentives awarded in 2019*
The following LTIP awards were granted during the year:
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to succeed

Pearson is transforming

Dear shareholders.

TR ayear of Signicant change for Pearson,
the Board and the Executive Management
team continued to work together to lay
the foundations to create a sustainable,
profitable, digitally-enabled organisation
which helps millions of learners make
progress through their lives.

IProgress and Eerformance

[Weentered Z0To Wit 3 determmaton T
return to growth on our top line and deliver
increased profit. However, despite a strong
performance across 76% of Pearson, a
|disappointing performance in our US Higher
[Education Courseware business, driven by

2 much quicker decline in print textbooks,
meant underlying Group revenue was flat.
Underlying adjusted operating profitwas

up 6% on 2018, in line with the bottom of our
guidance range. We acknowledge there are
still challenges to overcome and we remain
focused on building on the progress we

have made so far - Pearson is now a leaner,
Imore efficient and more digital company
with a strong balance sheet and this gives

us a platform from which we can address

these challenges.

Technology s disrupting every industry and
education is no exception. The US Higher

Executive. John has been n role for seven
years. Inthat time, he has worked tirelessly
tolead Pearson through a period of
significant change, and has been successful
intransforming it from a media conglomerate
toa single-focused learning company.

Under his leadership, Pearson has become
asimpler, more digitally-focused business,
underpinned by a stronger balance sheet

and better positioned to deliver a sustainable
and healthy future.

Such atransformation and shiftin the ways
acompany operates is never an easy change,
and the Board and I would like to thank

John for his significant contribution during
his tenure. A succession process is under
way that will consider both external and
internal candidates.

In January 2020, we announced that Coram
Williams, our Chief Financial Officer (CFO),
had informed the Board that he will be
leaving Pearson totake on a comparable

role elsewhere. On behalf of the Board,
Iwould like to thank Coram for the
fundamental role he has played in the
company’s achievements over the last five
years. We wish him all the best in his new role.

SallyJohnson, our current Deputy CFO,
will succeed Coram when he leaves Pearson
e,

Sidney Taurel
Chair

we announced an agreement to sell our
remaining 25% stake in Penguin Random
House to Bertelsmann for approximately
$675m. The formation of Penguin Random
House in 2013 created the first truly global
consumer book publishing company and

has created significant value for Pearson
shareholders, generating ¢.£1.9bn in net
disposal proceeds and dividends. The disposal
is enabling us to return capital to you, our
shareholders, through a £350m share
buybackwhich commenced in January 2020.

You can read more about these
accomplishments in the Chief Executive’s
overview that follows.

Maintaining financial strength
while looking to Pearson’s
longer-term future

The Board remains confident about Pearson's
medium and long-term prospects and our
‘growth opportunities are significant. Our
immediate focus is on improving financial
and operational performance and continuing
to grow the 76% of the business that
represents the future growth drivers of
Pearson. Our longer-term vision is to deliver
lifelong learning to customers, leading to

increased employability and work-related
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Performance targets for the 2020 awards to Executive Directors

> g Container <H1> Long-Term Incentive Plan (LTIP) Pat]

> iy Container <H2> Performance targets for the 2020 a| At the time the annual report was signed off for publication, the strategic goals for the company
1 over the next three years were still under development by the Board. The targets for the 2020
LTIP grant are therefore disclosed below and will be disclosed again in the RNS announcement

accompanying the grant, which is expected to be made in May as normal.
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| > g Container <P> The award will vest on 1 May 2023 sut]

> &g Container <[Body> +

[The award will vest on 1 May 2023 subject to the following performance conditions: |

> g Container <LBody> 1/3 of the award will be based of

1/3 of the award will be based on Pearson’s earnings per share (EPS) in 2022;

<
o > By Container <LBody> e based on Pearson’s net return on invested capital (Net ROIC) in
> & Container <LBody> 1/3 of the award will be based o 2022; and .
= 1/3 of the award will be based on Pearson'’s total shareholder return (TSR) performance
D [ JEEI AT LT D relative to the constituents of the FTSE 100 index over the three-year period 1 January
> g Container <LBody> 1/3 of the award will be based of 2020 to 31 December 2022
> g Container <LBody> FTSE B [Details of the performance targets for each of the performance conditions are set out in the

> &gl Container <LBody> 100 index over the three-year pel table below:

B[> & Contamer <P> Detals of the performance targets for} EPS (1/3) i Net ROIC (1/3) Relative TSR (1/3)
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Pearson

Role of Chair

A

The Chair is responsible for leadership of the board and
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Facilitating the effective contribution of non-exccutive directors and encouraging active
engagement by all members of the board.

Ensuring constructive relations between the executive and non-executive directors.

Holding meetings with the non-executive directors without the executives present.

Ensuring an appropriate balance of skills and personalites among the board members.
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